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Minimum requirements and components

Decipher IDP is a production ready IDP solution, closely integrated with Blue Prism. We recommend that

you deploy Decipher IDP on dedicated hardware to better support scalability as your use of Decipher IDP
increases. We also recommend installing and testing Decipher IDP in a non-production environment prior
to using it in a live environment.

é:, Decipher IDP is designed to provide an on-premise solution and is not supported in
SS&C Blue Prism Cloud at this time.

Minimum requirements

Decipher IDP

The following minimum setup is required to run Decipher IDP on a standalone deployment:
* Administrator access to the devices on which Blue Prism is installed.
* CPU: Intel i7 3rd generation or above.
* Windows 10, or Windows Server 2012 or later.

* RAM: 6 GB (1 GB for the application server at a load of 10,000 pages per day, plus 3 GB for SQL
Server, plus 2 GB for Windows).

* Hard drive space for image storage. The average file size is 1 MB per page and 1 TB per 1 million
pages.

Natural Language Processing (NLP) Plugin

The NLP plugin is an optional Decipher IDP component and has the following minimum requirements:

* A graphics card with a Nvidia Graphics Processing Unit (GPU) on it - installed on the same machine
as the Decipher automated client.

* 8 GB of RAM per each GPU.

° The version of the GPU driver must be 418.0 or later.

Supported browsers

Decipher IDP requires Google Chrome to be set as the default browser. Decipher IDP does not currently
support any other browsers.

Decipher IDP supports:
* Google Chrome

* Microsoft Edge

Minimum SQL permissions

The minimum SQL permissions for the user required to connect to the database during the installation
process must have the appropriate privileges to create or configure the databases from within the product,
therefore an appropriate administrator account will need to be used when running the installation process:

* Create Database: dbcreator (server role) or sysadmin (server role)

* Configure Database: sysadmin (server role) or db_owner (database role)
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The database user required to connect to the databases during normal operation must have the minimum
SQL permissions to access the Decipher IDP databases. The required permissions are:

* db_datareader

* db_datawriter

‘ @ For details on architecture and the projected performance, see the Sizing guide.

Commercial in Confidence Page 5 of 107


https://bpdocs.blueprism.com/decipher-2-2/en-us/Guides/Architecture/sizing.htm

Decipher IDP 2.2 | Installation and Configuration
Ssk ‘ bl Uepnsm Minimum requirements and components

Required components
The following software and database components are required to use Decipher IDP.

Third-party components

The following additional database and software components must be installed before installing Decipher
IDP. For details of these components, including download links, see Install/configure required software
components.

* RabbitMQ and Erlang
* SQL Server Express 2012 (or later) as a minimum requirement

£, SQL Server Express is supported for proof of concept and evaluation purposes only. It is not
recommended or supported for production use.

* SQL Server Management Studio

* Internet Information Server (11S)

Blue Prism and Decipher IDP components

The following components need to be installed and configured for this release of Decipher IDP. Download
the Decipher IDP components from the Decipher IDP page on the customer portal. For installation details,
see Install Blue Prism, Decipher VBO, and DLL and Install Decipher IDP.

Blue Prism BluePrism6.6.0_x64.msi or BluePrism6.6.0_x86.msi or later
Decipher DLL BluePrism.Decipher.VBO.Interop.dll
Blue Prism Decipher VBO BPA Object - Decipher.xml

Decipher Licensing Service  Decipher Licensing Service 0.1.984.0.msi

Decipher Server Decipher Server 2.22.10050.msi

Decipher Web Client Decipher Web Client 2.23.02150.msi
Decipher Automated Clients  Decipher Automated Clients 2.23.02140.msi
Server Plugin Decipher Server Plugin 0.1.984.0.msi

NLP plugin (optional) Decipher NLP Plugin 2.23.02140.msi
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Upgrade Decipher IDP

Blue Prism recommend that customers use the latest version of Decipher IDP. Download the required files
from the Decipher IDP portal page and update as described below.

Before you upgrade

Blue Prism strongly advise that existing Decipher IDP environments and databases are fully backed up
prior to upgrade, enabling the restoration of a working environment in the event of a failed installation. The
backup should be a system or full volume backup and not a backup of specific files within Decipher IDP.

When a Decipher environment is upgraded, all existing data, templates (Data Form Definitions) and
learning is retained. Once the upgrade is complete, all existing information is retained, but new functions
and features are now available for use, whether with newly created or existing Data Form Definition files.

Upgrade Decipher IDP 2.1t0 2.2
To upgrade from Decipher IDP 2.1 to 2.2:

1. Decipher Licensing Service - Run the Decipher Licensing Service.msi and click through the install
wizard, following the on-screen instructions as prompted. See Install Decipher licensing service for
details.

2. Decipher Server - Run the Decipher Server 2.22.10050.msi and click through the installation
wizard, following the on-screen instructions as prompted. The installation wizard will display your
current settings. Click Edit to amend the settings or create a new reporting database (see below for
details), or click Install to continue. See Install Decipher server for details.

To create a new, separate reporting database as part of this Decipher IDP upgrade (optional):

a. Click Edit on the Setup configurations summary screen.

45 Decipher Server Setup — X
Setup configurations
This is the setup configuration that you have @
Installation folder C:\Program Files (x86)Blue Prism\Dedpher Server,
SQL Server \SQLEXPRESS

Server Database name DecipherServerDb
Image storage path C:\Dedpher storage
Server TCP Port 12543

Install as service Yes

Enable storage encryption fake
Reporting SQL Server J\SQLEXPRESS

Bt |[ sl | | cancel

Commercial in Confidence Page 7 of 107


https://portal.blueprism.com/products/decipher

0 Decipher IDP 2.2 | Installation and Configuration
SSEC ‘blueprism Upgrade Decipher IDP

b. The Configure Server Settings screen displays.

5 Decipher Server Setup — X
Configure Server Settings
Please configure the server
Server Database Name: |DecipherServerDb
Image Storage Path: |C:\.Decipher storage |
Server TCP Part: 12543 |2
Install as Windows Service Enable reporting database
[] Encrypt All Data At Rest Reporting database on same server

[] Encrypt Configuration

Back | Next | | Cancel

c. Select Enable reporting database.
d. Click Install to complete the installation, then Finish to exit the wizard.

Decipher Web Client - Run the Decipher Web Client 2.23.02150.msi and click through the install
wizard, following the on-screen instructions as prompted. See Install Decipher web client for details.

Decipher Automated Clients - Run the Decipher Automated Clients 2.23.02140.msi and click
through the install wizard. The install wizard will display your current settings. See Install Decipher
automated clients for details.

£, When upgrading Decipher Automated Clients, the destination folder and configuration settings
are grayed out to ensure the existing installation configuration is retained.

Decipher Server Plugin - Run the Decipher Server Plugin.msi and click through the install wizard.
The install wizard will display your current settings. See Install Decipher server plugin for details.

Upgrade Decipher IDP 1.2t0 2.2
To upgrade from Decipher IDP 1.2t02.2 :

1.

Import the latest Decipher VBO, BPA Object - Decipher.xml, into Blue Prism and overwrite the
existing VBO.

Paste the BluePrismDecipher.VBO.Interop.dll file into C:\Program Files\Blue Prism Limited\Blue
Prism Automate, and replace the existing file.

Decipher Licensing Service - Run the Decipher Licensing Service.msi and click through the install
wizard, following the on-screen instructions as prompted. See Install Decipher licensing service for
details.

Decipher Server - Run the Decipher Server 2.22.10050.msi and click through the installation
wizard, following the on-screen instructions as prompted. The installation wizard will display your
current settings. Click Edit to amend the settings or create a new reporting database (see below for
details), or click Install to continue. See Install Decipher server for details.

To create a new, separate reporting database as part of this Decipher IDP upgrade (optional):
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a. Click Edit on the Setup configurations summary screen.

ﬂ Decipher Server Setup

Server Database name
Image storage path
Server TCP Port 12543
Install as service Yes
Enable storage encryption fake

Reporting SQL Server

Setup configurations
This is the setup configuration that you have @
Installation folder C:\Program Files (x85)\Blue Prism\Decipher Server),
SQL Server \SQLEXPRESS

DecipherServerDb
C:\Decipher storage

\SQLEXPRESS

Bt [ msal | | cancel |

b. The Configure Server Settings screen displays.

76 Decipher Server Setup - X
Configure Server Settings
Please configure the server
Server Database Name: DecipherServerDb
Image Storage Path: |C:\.Deupher storage |

Server TCP Port:

Install as Windows Service
[ Encrypt Al Data At Rest
[] Encrypt Configuration

Enable reporting database

Reporting database on same server

Back | Next | | Cancel

c. Select Enable reporting

database.

* If the existing reporting database is on the same server as Decipher Server, but you
want to create a database on a separate server, deselect Reporting database on same
server. The Reporting Database Server Configuration screen displays. Add the location
and credentials for the reporting database server and click Next.

d. Click Install to complete the installation, then Finish to exit the wizard.

5. Decipher Web Client - Run the Decipher Web Client 2.23.02150.msi and click through the install
wizard, following the on-screen instructions as prompted. See Install Decipher web client for details.

6. Decipher Automated Clients - Run the Decipher Automated Clients 2.23.02140.msi and click
through the install wizard. The install wizard will display your current settings. See Install Decipher

automated clients for details.

g, When upgrading Decipher Automated Clients, the destination folder and configuration settings
are grayed out to ensure the existing installation configuration is retained.

7. Decipher Server Plugin - Run the Decipher Server Plugin.msi and click through the install wizard.
The install wizard will display your current settings. See Install Decipher server plugin for details.
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ﬁ After upgrading to the latest version of the Decipher Server Plugin, the previous version will
need to be manually removed. From the Windows Start menu, open Settings > Apps, select
the Decipher Server Plugin and click Uninstall. This will be addressed in a future release.

Log locations

Decipher 2.1 introduced new default log locations for the Decipher clients. For details, see Decipher IDP
2.1 release notes. The log locations for existing installations upgrading from 1.2 to 2.2 will not be changed,
but the client config files can be manually updated to use the new log location.

Follow the steps below to update the config files for the following clients: OCR, Classification, Capture,
Export, Web client, Web SDK Service, and SDKWrapper.

1. Locate and open the config file as an Admin. For details on locations, see Default locations.
2. Inthe appSettings section, locate the 1.ogroot key and set to its value to "= rusL1C2".

3. Save the changes to the config file.
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Upgrade Decipher IDP 1.1t0 2.2
To upgrade from Decipher IDP 1.1t0 2.2:

1. Import the latest Decipher VBO, BPA Object - Decipher.xml, into Blue Prism and overwrite the
existing VBO.

2. Paste the BluePrismDecipher.VBO.Interop.dll file into C:\Program Files\Blue Prism Limited\Blue
Prism Automate, and replace the existing file.

3. Decipher Licensing Service - Run the Decipher Licensing Service.msi and click through the install
wizard, following the on-screen instructions as prompted. See Install Decipher licensing service for
details.

4. Decipher Server - Run the Decipher Server 2.22.10050.msi and click through the installation
wizard, following the on-screen instructions as prompted. The installation wizard will display your
current settings. Click Edit to amend the settings or create a new reporting database (see below for
details), or click Install to continue. See Install Decipher server for details.

E, If required, the separate reporting database must be created when installing/upgrading the
Decipher Server component.

To create a new, separate reporting database as part of this Decipher IDP upgrade (optional):

a. Click Edit on the Setup configurations summary screen.

5 Decipher Server Setup — X
Setup configurations
This is the setup configuration that you have @
Installation folder C:\Program Files (x85)\Blue Prism\Decipher Server),
SQL Server \SQLEXPRESS

Server Database name DecipherServerDb

Image storage path C:\Dedpher storage
Server TCP Port 12543
Install as service Yes

Enable storage encryption fake
Reporting SQL Server | \sQLEXPRESS

| Edt  [[(msal | | canl |

The Configure Server Settings screen displays.

76 Decipher Server Setup - X
Configure Server Settings
Please configure the server
Server Database Name: DecipherServerDb
Image Storage Path: |C:\.Deupher storage |
Server TCP Port: 12543 |3
Install as Windows Service Enable reporting database
[] Encrypt Al Data At Rest Reporting database on same server

[] Encrypt Configuration

Back Next | | Cancel
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b. Select Enable reporting databaseand click Next.
c. Click Install to complete the installation, then Finish to exit the wizard.

5. Decipher Web Client - Run the Decipher Web Client 2.23.02150.msi and click through the install
wizard, following the on-screen instructions as prompted. See Install Decipher web client for details.

6. Decipher Automated Clients - Run the Decipher Automated Clients 2.23.02140.msi and click
through the install wizard. The install wizard will display your current settings. See Install Decipher
automated clients for details.

7. Decipher Server Plugin - Run the Decipher Server Plugin.msi and click through the install wizard.
The install wizard will display your current settings. See Install Decipher server plugin for details.

Following upgrade
The following scenarios should be considered after upgrading Decipher IDP:

Scenario Action

You created a separate reporting If you need to copy existing reporting data from the Decipher
database as part of the upgrade database to the new reporting database see Reporting
process. database configuration for details.

You bound the Decipher IDP 1.1 Check whether the site setting has reverted to HTTP and
website to HTTPS, via Internet rebind if necessary.

Information Services (IIS) Manager.

Caching issues are impacting the Clear your browser cache following upgrade. This can be done
display of DFDs, document types, by pressing CTRL + F5.

and batch types across multiple

users.

If you encounter any issues after you have followed every step above and referred to the relevant sections
of this guide, please see Troubleshooting for further advice.
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Standalone deployment

Installation is a four-part process for a standalone deployment and must be installed and configured in the
following order:

Steps

For both standalone and multi-device installations, Decipher IDP must be installed and configured in the
following order. Each installation step has detailed instructions, or you can follow the relevant installation
video, where available.

https://bpdocs.blueprism.com/en-us/video/installation.htm.

‘ ® Instructional videos on how to install Decipher IDP and other Blue Prism products are available from: l

Installation Step Link to instructional video (if
available)

1. Install and configure third-party software

Erlang
RabbitMQ

SQL Server / SQL Server Express 2012 0
requirement)

r later (minimum

SQL Server Management Studio (recommend, but not

required)
Internet Information Server (I1S)

.NET framework

. Install and configure Blue Prism

* Install Blue Prism and create a Decipher
* Copy the Decipher DLL

database

* Import the Decipher VBO - Blue Prism interactive client

* Import the Decipher processes (release)

. Install Decipher IDP

Decipher Licensing Service

* Decipher Server
* Decipher Web Client

* Decipher Automated Clients

* Decipher Server Plugin

Commercial in Confidence

Install Erlang
Install RabbitMQ

/. The RabbitMQ management
plugin does not need to be
enabled, or a new user
configured, for standalone
deployments.

Install IS

Install .NET framework

* Copy DLL
° Import VBO

° Install Decipher Licensing Service

° Install Decipher Server

° Install Decipher Web Client

° Install Decipher Automated Clients

° Install Decipher Server Plugin
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Installation Step Link to instructional video (if
available)

4. Configure Decipher IDP
° Configure database access ° Configure database access — non-
* Grant system access (NT AUTHORITY) to the Decipher production environments

database (non-production environments only) ° Configure database access -

* Configure Windows Authentication (production production environments

environments). ° Add Decipher SQL location to
Web.config

* Secure the Decipher website with a Secure Sockets Layer
(SSL) (production environments). * Activate Sites and Services for

* Add Decipher SQL location to Web.config Decipher IDP

* Check all Decipher services are running

* Activate Sites and Services for Decipher IDP

* Enable machine learning training (optional)

5. Log onto Decipher IDP
° You are ready to get started with Decipher IDP ° Log onto Decipher IDP
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Install and configure third-party software

You need to install and configure the following software and settings in the order listed below on a
dedicated PC before installing Decipher IDP.

ﬁ Please ensure that you have read the minimum requirements section, including the browser details,
before installing the third-party software and Decipher IDP components.

Erlang and RabbitMQ

The following components must be installed before installing Decipher IDP:
* Erlang OTP version 25.1.2
* RabbitMQ version 3.11.4

Function Erlang and RabbitMQ are required components and must be installed on the machine
on which the Decipher Web Client will be installed.

ﬁ RabbitMQ is installed using a default username and password. These credentials
are then automatically populated during the installation of the Decipher licensing
service. If you do not want to use the default RabbitMQ credentials, you will need
to amend them before installing Decipher licensing service and enter the new
credentials during installation. For details on changing the default credentials,
see RabbitMQ configuration.

Download The version of Erlang that you require is dependent on the RabbitMQ version you
intend to use. For more information, see RabbitMQ Erlang Version Requirements.

https://www.erlang.org/downloads
https://www.rabbitmqg.com/download.html

Install Run the installers and follow the instructions, accepting the default options when
prompted.
SQL Server
Function SQL Server Express 2012 is a minimum database requirement.

ﬁ. SQL Server Express is supported for proof of concept and evaluation purposes
only. Itis not recommended or supported for production use.

Download https://www.microsoft.com/en-us/sql-server/sqgl-server-downloads

SQL Server Express 2012 (or later) is the minimum requirement for a standalone
deployment of Decipher IDP.

Supported SQL Server Express 2012, 2016, 2017, 2019

SPPECAEIN SQL Server 2012, 2014, 2016, 2017, 2019
versions
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Run the installer and when prompted, select the basic installation type.

SQL Server 2019
Express Edition

Select an installation type:

é". The Blue Prism Decipher database should not be created at this stage of the
installation process. See Create a Blue Prim database for Decipher IDP on
page 64 for details.

SQL Server Management Studio

Function This is not a requirement for Decipher IDP installation, but is recommended to
configure and manage components within the SQL server.

For multi-device installations this will need to be installed on a user’'s machine only
where required.

Download https://docs.microsoft.com/en-us/sqgl/ssms/download-sql-server-management-studio-
ssms?redirectedfrom=MSDN&view=sql-server-ver15.

Under Download SSMS, click Download SQL Server Management Studio (SSMS) to
download the SSMS-Setup-ENU.exe.

Run the installer and follow the instructions, accepting the default options when
prompted.
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Internet Information Server (11S)

IIS needs to be configured on the web server. |IS settings are applied from the Windows control panel:
Programs > Programs and Features > Turn Windows Features on or off and select Internet Information
Services.

Ensure the following settings are applied:
Web Management Tools IIS Management Console

World Wide Web Services Application Development Features
* .NET Extensibility 3.5

* .NET Extensibility 4.7
° ASP .NET 4.7

* ISAPI Extensions

* ISAPI Filters

Common HTTP Features
° Default Document

* Directory Browsing
* HTTP Errors

° Static Content

Health and Diagnostics N/A
Performance Features N/A
Security N/A

Scripted installation

To apply the above settings automatically, run the command below using the PowerShell command
prompt:

Install-WindowsFeature -Name Web-Mgmt-Console, Web-Net-Ext, Web-Net-Ext45, Web-Asp-Net45, Web-
ISAPI-Ext, Web-ISAPI-Filter, Web-Default-Doc, Web-Dir-Browsing, Web-Http-Errors, Web-Static-
Content -computerName localhost -Restart
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.NET Core Components

Function The .NET Core components must be downloaded and installed.

Download Download the following components and store them in a temporary location, for
example, C:\temp:

* .NET Core Windows Server Hosting 3.1.3

https://dotnet.microsoft.com/en-us/download/dotnet/thank-you/runtime-
aspnetcore-3.1.3-windows-hosting-bundle-installer

* .NET Core Windows Desktop Runtime 3.1.3

https://dotnet.microsoft.com/en-us/download/dotnet/thank-you/runtime-desktop-
3.1.3-windows-x64-installer

* Visual C++ Redistributable 2012 (x64)

https://download.microsoft.com/download/1/6/B/16B06F60-3B20-4FF2-B699-
5E9B7962F9AE/VSU_4/vcredist_x64.exe

° .NET Framework 4.7.2

https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net472-
web-installer

ﬁ, This is installed by default on Windows Server 2019. You only need to install
the .NET Framework if you are using Windows Server 2016.

Install To install the .NET dependencies, run each of the following commands using the
PowerShell command prompt, waiting until each completes, before running the next
command:

For Windows Server 2016:

start-process "C:\temp\dotnet-hosting-3.1.3-win.exe" /q -wait
start-process "C:\temp\windowsdesktop-runtime-3.1.3-win-x64.exe" /q -wait
start-process "C:\temp\vcredist_x64.exe" /q -wait

start-process "C:\temp\NDP472-KB4054531-Web.exe" /q -wait

For Windows Server 2019:

start-process "C:\temp\dotnet-hosting-3.1.3-win.exe" /q -wait
start-process "C:\temp\windowsdesktop-runtime-3.1.3-win-x64.exe" /q -wait
start-process "C:\temp\vcredist_x64.exe" /q -wait

ﬁ Ensure the file name and file path match the files that were stored in step 1.

Restart your server before installing Decipher IDP to ensure the components are fully
installed and registered.
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RabbitMQ configuration

If required, you can amend the default RabbitMQ credentials.

Enable RabbitMQ management plugin
To create enable the RabbitMQ plugin:

1. From the Start menu, under the RabbitMQ Server folder, select the RabbitMQ Command Prompt
(sbin dir).

2. Inthe RabbitMQ Command Prompt window, type the following command:
rabbitmg-plugins enable rabbitmg management

Customize RabbitMQ credentials and set permissions

If you do not want to use the default RabbitMQ credentials, you can create a new user with custom
credentials, or update the credentials used by the default RabbitMQ user:

1. Open a browser and navigate to http://localhost: 15672/.

The RabbitMQ Management login screen displays.
2. Loginto RabbitMQ using guestas both the username and password.
3. Select the Admin tab and click Add user.

Overview Connections Channels Exchanges Queues @

Users

w All users

Filter: [JRegex 7

Name Tags Can access virtual hosts  Has password
decipheruser administrator /. pssandbox -
guest administrator / .

?

w Add a user

Username; | guest

Password: v

Tags:

* {confirm)
?

S5et Admin | Monitoring | Policymaker

Management | Impersonator | Mone

ﬁ If you do not want to create a new user, you can also change the username and password of
the default RabbitMQ user.

4. Add the username and password for the user.
5. Inthe Tags field, enter administrator.
6. If adding a new user, click Add user.

Once created, the new user will display in the All users list.
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7. To grant administrator permissions, in the All users list, select the relevant user.

The Permissions page for the selected user displays.

Overview Connections Channels Exchanges Queueas m

User: decipheruser

+ Overview

Tags | administrator

Can log in with password =«

+ Permissions

Current permissions

virtual host | Configure regexp Write regexp Read regexp

/ & - -

Set permission

Virtual Host:

Configure regexp:
Write regexp:

Read regexp:

8. Inthe Set permission dialog, ensure the Virtual Host field contains the / character and do not amend
the other default parameter settings.

9. Click Set permission to apply these permissions to the new user.

10. Run the installers for Decipher Licensing Service and Decipher Server. On the RabbitMQ
connection configuration screen enter the RabbitMQ credentials as configured above. For details,
see Install Decipher IDP components.

11. Run the installers for Decipher Web Client, Decipher Automated Clients, and Decipher Server
Plugin.

12. Open the following config files, and in the appSettings node, populate the RabbitMQHost with just
the hostname or IP address of the RabbitMQ server; and populate the RabbitMQUsername and
RabbitMQPassword attributes with the relevant credentials and save the changes.

Web.config C:\Program Files (x86)\Blue Prism\Decipher Web

Ssi.SdkService.exe.config C:\Program Files (x86)\BluePrism\Decipher Web SDK Service

Ssi.SdkWrapper.exe.config C:\Program Files (x86)\BluePrism\Decipher Web SDK
Service\SdkWrapper

g, Credentials are entered as plain text. For enhanced security, the credentials can be encrypted.
For more information, see Encrypt credentials on the next page.

13. Open Internet Information Services (IIS) Manager and select the Decipher website from the
navigation tree.
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14. Under Manage Website in the right-hand pane, click Restart.

15. Using Windows Services, restart RabbitMQ and all Decipher Services (Decipher Licensing Service,
Decipher Server, Decipher Web Client, and Decipher Automated Clients).

16. Restart your machine.
The RabbitMQ user is now set up and ready for use with Decipher IDP.

Encrypt credentials

As part of this configuration, RabbitMQ credentials are entered as plain text. While the Web.config
automatically encrypts the credentials after first login, values are kept as plain text in the
Ssi.SdkService.exe.config and Ssi.SdkWrapper.exe.config files. To be able to encrypt the credentials in all
the files, the account running the Decipher Web SDK service must have write permissions to the Decipher
installation folder. The default network service account will not have sufficient permissions. To change the
account:

From Windows Services, right-click the Decipher Web SDK service and select Properties.
Click the Log On tab and select This account.

Enter the location and password of the relevant account, and click OK.

> w =

In Windows Services, restart the following Decipher services: Decipher Licensing Service, Decipher
Server, Decipher Web Client, and Decipher Automated Clients.

5. Log into Decipher IDP.
Upon successful login to Decipher IDP, the credentials are encrypted in all three config files. If required,
you can change the service to use the original account after the credentials have been encrypted.
Update default credentials for existing installations
If required, you can change the default credentials for existing installations:
1. From the Windows Start menu, open Settings > Apps, select the Decipher Licensing Service and
click Modify. The Decipher Licensing Service Setup dialog displays.

2. Onthe Change, repair, or remove installation screen, click Change. Proceed through the wizard. On
the RabbitMQ connection configuration screen, enter the new RabbitMQ credentials as configured
above.

3. Uninstall and reinstall Decipher Server. During installation, on the Licensing screen, enter the new
RabbitMQ credentials.

4. Open the following config files, and in the appSettings node, populate the RabbitMQHost with just
the hostname or IP address of the RabbitMQ server; and populate the RabbitMQUsername and
RabbitMQPassword attributes with the relevant credentials and save the changes.

Config file Default location

Web.config C:\Program Files (x86)\Blue Prism\Decipher Web

Ssi.SdkService.exe.config C:\Program Files (x86)\BluePrism\Decipher Web SDK Service

Ssi.SdkWrapper.exe.config C:\Program Files (x86)\BluePrism\Decipher Web SDK
Service\SdkWrapper

£> Credentials are entered as plain text. For enhanced security, the credentials can be encrypted.
For more information, see Encrypt credentials above.
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5. Open Internet Information Services (IIS) Manager and select the Decipher website from the
navigation tree.

6. Under Manage Website in the right-hand pane, click Restart.

7. Using Windows Services, restart RabbitMQ and all Decipher Services (Decipher Licensing Service,
Decipher Server, Decipher Web Client, and Decipher Automated Clients).

8. Restart your machine.

The credentials used for RabbitMQ are now updated and ready for use with Decipher IDP.
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Install and configure Blue Prism
The following components are required to complete the steps below:

* Blue Prism

* Decipher DLL

* Decipher VBO

* Decipherv2.2.bprelease

‘ ﬁ For details of component versions see the release notes.

Install Blue Prism and create a database

If you do not already have Blue Prism installed, you will need to install Blue Prism 6.6 or later. If you
already have Blue Prism installed you just need to create a Blue Prism database for use with Decipher IDP
-you will need to reference this when installing the Decipher Licensing Service.

This is an overview of the steps required to install Blue Prism and create a database. You can find full
instructions on how to install, configure, and use our product in the Blue Prism help.
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Create a Blue Prim database for Decipher IDP
You need to create a new database for your Decipher IDP data.
Install and launch Blue Prism.

2. Inthe Sign in to Blue Prism screen, click Configure connection to launch the configure connection
wizard.

3. Click New Connection followed by Create Database.
In the Connection Configuration screen complete the following details:

Connection Name Enter an easily recognizable name for the connection.
Connection Type Select SQL Server (Windows Authentication).

Database Server Enter the network location of the SQL server instance.
If you have installed SQL Express as described in this
guide, this will be localhost\SQLEXxpress.

Database Name Enter a name for the new database, e.g. BluePrism.

/. BluePrismis the default database name when
installing the Decipher licensing service. If you
create a database using a different name, you
will need to enter this name when you install the
Decipher licensing service.

Additional SQL Connection This is not required.
Parameters

i Connection Configuration ? *

Store and recall different database connections

Saved Connections ‘Current Connection
Decipher
Connection Name Decipher
The name by which this connection will be remem bered
Connection Type SOL Server (Windows Authentication) ~
The type of connection to use
Database Server ‘Ioca\host\SQLExpress
The hostname of the database server
Database Name BlueFrism|
The name of the database to connect to
Additional SQL ‘
Connection Parameters  c.o; ooy separated parameters to add 1o the connection string
Test Connection
MNew Connection Delete Connection Create Database Upgrade Database Configure Database
OK Cancel

5. Select your required user authentication method and click OK to create the database.

Add Decipher IDP license to SS&C Blue Prism

You need a Decipher IDP license to run Decipher. This must be added to Blue Prism before installing
Decipher IDP.
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1. Log into Blue Prism.

ﬁ Ensure that you log into Blue Prism using the connection configured to use the database
created for Decipher IDP. This is because Decipher licensing will not work unless you apply
the license key to the Decipher database. You also need to ensure you specify this database

when installing the Decipher Licensing Service.

2. Click the System tab and select System > License from the navigation tree. Details of the active
license are displayed and options are available to install new licenses and remove existing ones.

3. Click Install new license to add the Decipher license.
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Add the Decipher DLL

For multi-device installations (any interactive client or runtime resource that will run the Decipher Blue
Prism processes), this DLL needs to be copied to the Blue Prism install location for all Blue Prism
interactive clients and runtime resources using Decipher IDP.

Paste the BluePrismDecipher.VBO.Interop.dll file into ¢ : \pProgram Files\Blue Prism Limited\Blue
Prism Automate.

This is the default install location so adjust it if you have used an alternative - just make sure it is in the
same directory as Automate.exe.

| = | Manage Blue Prism Automate — O x
Home Share View Application Toals - @
€« v 4 » ThisPC » 0O5(C) » Program Files (x86) » Blue Prism Limited » Blue Prism Automate v O Search Blue Prism Au.. 0
Program Files (x26) ~ MName - Date modified Type Size "
Adobe [] AppMan32.exe 28/01/2020 10:47 Application 46 KB
ASM104xUSE3 ¥ AppMan32.exe.config 28/01/2020 10:37 XML Configuratio... 5KB
AVAST Software Autofac.dll 16/10/2017 09:33 Application extens... 213 KB
Blue Prism Autofac.Extras.MLog.dll 24/05/201517:10 Application extens... 23 KB
. e > Automate.exe 28/01/2020 10:49 Application 169 KB
Blue Prism Limited ¥ Automate.exe.config 28/01/2020 1037 XML Configuratio.. 6 KB
Common Files AutomateAppCore.dll 28/01/202010:47  Application extens... 1,887 KB
CORVID [5] AutomateC.exe 28/01/2020 10:47  Application 129 KB
Dell %21 AutomateC.exe.config 28/01/2020 10:37 XML Configuratio... 5KB
Dell Digital Delivery Services iy AutomateConfig.exe 28/01/2020 10:47 Application 1,643 KB
dotnet ¥ AutomateConfig.exe.config 28/01/2020 10:37 XML Configuratio... 5KB
DurnrmyDir AutomateControls.dll 28/01/2020 10:46 Application extens... 844 KB
AutomateProcessCore.dll 28/01/2020 10:47 Application extens... 1,173 KB
Google B AutomateS.exe 28/01/202010:46  Application 2,327KB
InstaliShield Installation Information AutomateUL.dll 28/01/202010:49  Application extens... 12,950 KB
Intel BluePrism.ActiveDirectorylserSearcherdll  22/01/2020 10:47 Application extens... 220 KB
Internet Explorer v BluePrism.Browserfutomation.dll 28/01,/2020 10:46 Application exens... 95 KB W
149 items 1itemn selected 168 KB f=z| =

Commercial in Confidence Page 26 of 107



Decipher IDP 2.2 | Installation and Configuration
SSk ‘ b|uepl’lsm Standalone deployment

Import the Decipher VBO
In Blue Prism select File > Import and import the BPA Object - Decipher.xml. This Decipher VBO can also
be used to create your own processes.

B Action Properties ? - O X

MName: Get Next Completed Batch
Description:

Business Object |De\:||:her = ‘ o Group:

Action |Get Mext Completed Batch " [rage [ Data Type

Inputs  Outputs  Conditions [ view Al items

Name Data Type Walue Binaries
[Queue Suffiy] - Collections

Dates

-~ DateTimes
Flags

. Images
Numbers

- Passwords
Text

.. Times

- TimeSpans

Stage logging: [ Dont log parameters on this stage
‘wiarning threshold: MNumber of minutes (0 to disable) I QK I | Cancel
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Import the Decipher release
Import this release into each separate Blue Prism environment that needs to interact with Decipher IDP.

The Decipher v2.2.bprelease contains a number of pre-built processes to help you use Decipher IDP.

Process Function Details
Decipher-01Push = Takes documents located in C:\/nvoices and Do not include more than
Documents pushes them to Decipher IDP as a single batch. 15 invoices in a batch.
Decipher - 02 Sample process to determine whether there are This returns True or
Batches to Verify batches in Decipher IDP that require manual False and can be used to
verification. build a process to send
notifications to users.
Decipher - 03 Get Sample process to retrieve verified documents N/A
Verified Documents  from Decipher IDP and put in a Blue Prism work
queue.
Decipher - 04 Get Takes the document data from Blue Prism work N/A
Decipher Item from = queue and pushes data into collection.
BP Queue

Select File > Import and select the Decipher v2.2.bprelease you downloaded from the portal. The
processes are added to the Processes\Default folder in Studio.
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Install Decipher IDP components

g, Before installing the Decipher IDP components, you will need to apply a valid Decipher IDP license to
the Decipher database in Blue Prism for Decipher IDP to work. See Decipher IDP licensing for
details.

The following components are required to complete the Decipher IDP installation and steps below and
must be installed in this order:

Decipher Licensing Service
Decipher Server
Decipher Web Client

Decipher Automated Clients

a bk~ wh =

Decipher Server Plugin

g, If you have already installed the beta version of Decipher IDP, you will need to use Windows
Add/Remove Programs to remove all of the (beta) Decipher components from all devices, before
installing this release. To avoid any issues, please then follow these installation instructions when re-
installing Decipher IDP.

You can download these files from the Decipher IDP product page of our customer portal. You can see the
component versions for each release in the release notes.

Depending on your current system setup you may need to restart your computer following installation
before Decipher IDP can be used.

Install Decipher Licensing Service

ﬁ RabbitMQ is installed using a default username and password. These credentials are then
automatically populated during the installation of the Decipher licensing service. If you do not want to
use the default RabbitMQ credentials, you will need to amend them before installing Decipher
licensing service and enter the new credentials during installation. For details on changing the
default credentials, see RabbitMQ configuration.

For multi-device installations, this needs to be installed on the Decipher Licensing Service.

1. Run the Decipher Licensing Service installer.

2. Click through the install wizard, following the on-screen instructions as prompted.
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3. Onthe End-User License Agreement screen, read the license agreement and select / accept the
terms in the License Agreement, if you accept these terms.

@ Decipher Licensing Service Setup — X
End-User License Agreement
Please read the Decipher Licensing Service License Agreement @
DECIPHER INTELLIGENT DOCUMENT ~
PROCESSING

END USER LICENSE AND SUPPORT TERMS

‘We (Blue Prism Software, Inc. (if you are in the Americas) or Blue Prism Limited (if vou are
in any other jurisdiction) are making the Decipher Intelligent Document Processing products
(the “Software™) and associated support services available to you.

These End User Licensze and Support Terms, and the order (where “order” means an order
on the Blue Prism Order Form or other document agreed with us, or between you and an
authorized Blue Prism reseller (“Reseller™)), contain the whole agreement between you and

e ralatine tn tha ehiset mabter harand and cab nnb bha baeme e tehich sn sen nea tha

v

[ | accept the terms in the License Agreement

[ Pt || Bak || met | | canel |

4. On the Destination Folder screen, click Next to accept the default location for Decipher Licensing
Service or click Change to specify a different location.

@ Decipher Licensing Service Setup — =

Destination Folder

Click Mext to install to the defautt location 6 bl u e p ”S m

Install Decipher Licensing Service to:

|C:\Program Files {x86)\Blue Prism"Decipher Licensing Service

Back || Net | | Cancel
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5. On the Configure SQL connection screen:
Ensure the correct SQL server is specified.

b. The Trusted (Windows Authentication) authentication mode is selected by default. This
setting is recommended for Decipher IDP, but can be changed if required.

A\ If using SQL Authentication, ensure your SQL password does not start with an equals
(=) sign or a semi-colon (;) as they are not supported and may lead to a corrupted
configuration file.

c. Enterthe name of your existing Blue Prism database. The Database name defaults to
BluePrism. If you have already created a Blue Prism database for Decipher using a different
name, enter that name in the Database name field.

ﬁ If you don’t enter the correct Decipher database name during this part of the installation,
as described above, Decipher IDP will not successfully run.

3 Decipher Licensing Service Setup — *
Configure SQL connection

Flease enter details for a SQL server instance for the Decipher Server to use

Please select SQL Server |BPEU292‘\SQLEXPRESS ~ | | Refresh

Authentication Mode
(® Trusted (Windows Authentication)
() Spedfy Username and Password (SQL Authentication)

Username

Password

Database name  |BluePrism

Back || mMext | | Concel
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6. On the RabbitMQ connection configuration screen the following details are completed by default:

The hostname of your RabbitMQ server. Commonly in development environments,
all components are installed on the same server, and therefore the default is
localhost. For multi-device environments, you will need to enter the name of the
RabbitMQ server.

Defaults to 5672.

Defaults to DecipherLicensing.

P Decipher Licensing Service Setup — x

RabbitMQ connection configuration
Amend the following RabbitMQ connection values as required

Host name

Port 5672 H

Queue name |DecipherLioensing

| Back || MNext | ‘ Cancel |

7. Click Next to continue. A message displays notifying you that a queue using the name you have
specified will be created in RabbitMQ. Click Yes to accept, or No if you want to go back and amend
the name.

8. On the RabbitMQ connection configuration screen enter the username and password for RabbitMQ.
The default is guest.

/. The RabbitMQ username and password entered here must match the RabbitMQ account - the
default RabbitMQ username and password are guest. For standalone deployments, the default
credentials are sufficient. If you created a different RabbitMQ user, enter the credentials for the
new user. You will be prompted to enter these credentials when installing the Decipher server.

9. Click Next.

10. On the Installation Summary screen, click Install to complete the installation, followed by Finish to
exit the wizard.

£, When the Decipher Licensing Service is installed, it is automatically configured with a default
RabbitMQ connection timeout of 5 seconds. If required, you can update the timeout value. For more
information, see Configure RabbitMQ connection timeout.
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Install Decipher Server

ﬁ If required, the separate reporting database must be created when installing/upgrading the Decipher
Server component.

For multi-device installations, this needs to be installed on the Decipher server.

1. Run the Decipher Server installer.
2. Click through the install wizard, following the on-screen instructions as prompted.

3. Onthe End-User License Agreement screen, read the license agreement and select / accept the
terms in the License Agreement, if you accept these terms.

75 Decipher Server Setup - X

End-User License Agreement ~
Please read the Decipher Server License Agreement @

Ll

DECIPHER INTELLIGENT DOCUMENT
PROCESSING

END USER LICENSE AND SUPPORT TERMS

'We (Blue Prism Software, Inc. (if you are in the Americas) or Blue Prism Limited (if you are
in any other jurisdiction) are making the Decipher Intelligent Document Processing products
(the “Software”) and associated support services available to you.

These End User License and Support Terms, and the order (whers “order” means an order
on the Blue Prism Order Form or other document aereed with us. or between vou and an v

| accept the terms in the License Agreement

Pt || Back || Nee | | Camcel |

4. On the Destination Folder screen, click Next to accept the default location for Decipher Server or
click Change to specify a different location.

ﬂ Decipher Server Setup — =

Destination Folder =
Click Mext to install to the default folder or click Change to choose anather. @

Install Decipher Serverto:

|C:\F‘rogram Files {x86)Blue Prism"Decipher Server
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5. Onthe Licensing screen, enter the following licensing details:

* Host name - The hostname of your RabbitMQ server. Commonly in development
environments, all components are installed on the same server, and therefore the default is
localhost. For multi-device environments, you will need to enter the name of the RabbitMQ
server.

* Queue name - The RabbitMQ queue name. The default is DecipherLicensing.

* Username and Password - The username and password for the RabbitMQ account that you
entered when installing the Decipher Licensing Service. The default RabbitMQ username and
passwords are guest, these credentials can only be used for standalone deployments.

g For multi-device deployments, you will need to first create a new RabbitMQ user to
access to RabbitMQ server remotely, see Create new RabbitMQ user and set
permissions for details. You will also need to modify the RabbitMQ instance on the
Decipher Server to configure remote access to the RabbitMQ server, see Modify the
RabbitMQ instance on the Decipher Serverfor details.

75 Decipher Server Setup - *

Licensing ~
Licensing credentials @
Host name: Port:
[localhost | [s672 H
Queue name:
|DecipherLicensing |
Usemame:
|g|.|est |
Password:
|.....| |

Back || Net | | Cancel |
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6. Onthe Database Server Configuration screen:
a. Ensure the correct SQL server is specified.

ﬁ If the SQL server is the MSSQLSERVER default instance, enter the machine name or
localhost. Entering the full name will result in the server not being found. Alternatively, if
you need to provide a different instance name, enter the machine name or localhost,

followed by | and the instance name.

b. The Trusted (Windows Authentication) authentication mode is selected by default. This
setting is recommended for Decipher IDP, but can be changed if required.

c. Click Test connection to proceed, followed by Next to continue.

;@ Decipher Server Setup — =

Database Server Configuration
Please configure database server connection
Click refresh to view LAN SQL Instances. Type URL or IP for remote SQL Instances
v||  Refresh |

Flease select SQL Server: |.‘\SQLEXPRESS

Authentication Mode
(@) Trusted (Windows Authentication)
(C) Spedify Username and Password (SQL Authentication)

Username:

Password:

Test connection to proceed
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7. Onthe Configure Server Settings screen complete the following details:

Server Database
Name

Image Storage Path

Server TCP Port

Install as Windows
Service

Encrypt All Data At
Rest

Encrypt Configuration

Enable reporting
database

Reporting database
on same server

Enter a new name for the server database, or accept the default
DecipherServerDb.

Enter the location in which to store the documents after they have
been processed. This can be any location, including OneDrive,
SharePoint, or a local drive. For example C:\Decipher storage.

Accept the default TCP port, or enter a different port number if
required. You will need to enter this port number when installing the
Decipher Web Client.

This option is selected by default. Do not deselect this option.

Select this option if you want to store all completed documents as
encrypted files. This is only necessary if the documents being
processed are confidential.

If enabled, you will need to configure an encryption password. If
enhanced security is required, enable the Encrypt the password
option.

ﬁ Decipher Server Setup — x
-
Encryption
Encryption corfiguration @

Encryption password:
| |

Corfirm password:

[ Encrypt the password

Back Next Cancel

Select this option if you want to encrypt the server settings.

Select this option to create a separate reporting database. A separate
reporting database enables you to retain report data for much longer.
This is also required to populate the accuracy and automation rates
reports.

For details of how to copy any existing reporting data from the
Decipher database to the new reporting database, see Reporting
database configuration.

If selected, the reporting database will be created on this server. This
option is selected by default.

ﬁ If required, the separate reporting database must be created when installing/upgrading the
Decipher Server component.
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}@ Decipher Server Setup — *

Configure Server Settings
FPlease configure the server @

Server Database Name: |Decipher5erverDb |
Image Storage Path: | Tl
Server TCP Port: 12543 |3
[ 1nstall as Windows Service ] Enable reporting database
[] Encrypt Al Data At Rest [~] Reporting database on same server
[] Encrypt Configuration

Back || MNext | | Cancel

8. Click Next.

9. On the Installation Summary screen, click Install to complete the installation, followed by Finish to
exit the wizard.
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Install Decipher Web Client

For multi-device installations, this needs to be installed on the Decipher web server.
Run the Decipher Web Client executable.
Click through the install wizard, following the on-screen instructions as prompted.

On the End-User License Agreement screen, read the license agreement and select / accept the
terms in the License Agreement, if you accept these terms.

75 Decipher Web Client Setup - x

End-User License Agreement ~
Please read the Decipher Web Client License Agreement B

Ll

DECIPHER INTELLIGENT DOCUMENT
PROCESSING
END USER LICENSE AND SUPPORT TERMS
'We (Blue Prism Software, Inc. (if you are in the Americas) or Blue Prism Limited (if you are

in any other jurisdiction) are making the Decipher Intelligent Document Processing products
(the “Software”) and associated support services available to you.

These End User License and Support Terms, and the order (whers “order” means an order

ion the Bine Prism Order Form or other doenment aereed with n= or hetween von and an v

[ | accept the temma in the License Agreement

Pit || Back || Nex | Cancel
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4. On the Configuration screen complete the following details:

DESILENC M Accept the default install location.
Folder

Web Site Accept the default web site port, or enter a different port number if required.
Port

AVoJolI[e=1i[e]s M This IP address is required when you install the Decipher server.
Server
IP/URL

Ensure the same port number entered for Decipher Server is entered here.

AVsJolI[e1i[e]s M Enter the name of the SQL database connection. If you accepted the default
Database settings whilst installing Decipher Server, this will be:
Connection

Strmg Data Source=.\SQLEXPRESS;Initial Catalog=DecipherServerDb;Integrated
Security=True

If you didn’t accept the default options, this can be found in the
SsiServer.exe.config file, which is located in C:\Program Files (x86)\Blue
Prism\Decipher Server by default.

75 Decipher Web Client Setup - *

Decipher Web Client
Configuration
Destination Folder
|C:\Program Files (x86)Blue Prism | | Browse... |

Web Site Port:

Application Server IPYURL: Server Port:
[127.0.0.1 | [12543

Application Database Connection String
|3&=.\,5QLEXPRE55;InmaI Catalog=DedpherServerDb;Integrated 5ecur|ty=TrueI|

| Bak || met | | concel

5. Click OK to save the settings.

6. Click Install to continue to install Decipher Web Client, which may take several minutes, followed by
Close to exit the wizard.

ﬁ Windows security alerts may display for the erl.exe and the epmd.exe. For Decipher IDP to work
successfully you will need to allow them to communicate over your private networks.
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Install Decipher Automated Clients

For multi-device installations, this needs to be installed on the Decipher clients server.
1. Run the Decipher Automated Clients installer.
2. Click through the install wizard, following the on-screen instructions as prompted.

3. Onthe End-User License Agreement screen, read the license agreement and select / accept the
terms in the License Agreement, if you accept these terms.

ﬁ Decipher Automated Clients Setup — x

End-User License Agreement ~
Please read the Decipher Automated Clients License Agreement B

DECIPHER INTELLIGENT DOCUMENT
PROCESSING

END USER LICENSE AND SUPPORT TERMS

'We (Blue Prism Software, Inc. (if you are in the Americas) or Blue Prism Limited (if you are
in any other jurisdiction) are making the Decipher Intelligent Document Processing products
(the “Software”) and associated support services available to you.

These End User License and Support Terms, and the order (whers “order” means an order

ion the Bine Prism Order Form or other doenment aereed with n= or hetween von and an v

| accept the terms in the License Agreement

Pt || Back || Nee | | Camcel |

4. On the Destination Folder screen, click Next to accept the default location for Decipher Automated
Clients or click Change to specify a different location.

ﬁ Decipher Automated Clients Setup — =

Destination Folder >
Click Next to install to the default folder or click Change to choose anather. @

Install Decipher Automated Clients to

|C:\F‘rogram Files {(x86)Blue Prism"Decipher Automated Clients
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5. Onthe Custom Setup screen, select the relevant options.

For standalone deployments, select every option. For multi-device deployments, with multiple
automated clients, select only the features required for each installation.

ﬁ Decipher Autorated Clients Setup - >

-
Custom Setup
Select the way you want features to be installed. @

Click the icons in the tree below to change the way features wil be installed.

[ Classfication Cliernt

[-]10OCR Cliert

Data Capture Cliert
Machine Leaming Module

Export Cliert

Image Processing Client

6. On the Decipher Automated Clients Configuration Settings screen complete the following details:
Server IP/URL Ensure the same IP address entered in the Decipher Server is entered
here. The default IP address is 127.0.0.1.

Ensure the same port number entered for Decipher Server and the
Decipher Web Client is entered here. The default portis 72543.

Username generaluser This is the Decipher user that will run the different
modules to extract data from a document.

Password user

=Yoo lyiife [T 1] M Select this option to encrypt the Automated Client configuration
settings.

ﬁ Decipher Automated Clients Setup - >

Decipher Automated Clients Configuration Settings

Specify Application server connection settings
Server IPJURL |12?.0.0. 1 |

Port |12543 E"

Username |generaluser |

Password | |

[] Encrypt Configuration

Mote: The system is configured with a user "generaluser” with a password "user” by default.

| Bak || mswl | caneel |

7. Click Install to complete the installation, followed by Finish to exit the wizard.
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Install Decipher Server Plugin
For multi-device installations, this needs to be installed on the Decipher server.
1. Run the Decipher Server Plugin installer.
2. Click through the install wizard, following the on-screen instructions as prompted.

3. Onthe End-User License Agreement screen, read the license agreement and select / accept the
terms in the License Agreement, if you accept these terms.

i Decipher Server Plugin Setup — x
End-User License Agreement
Please read the Decipher Server Plugin License Agreement @
DECIPHER INTELLIGENT DOCUMENT ~
PROCESSING

END USER LICENSE AND SUPPORT TERMS

‘We (Blue Prism Software, Inc. (if you are in the Americas) or Blue Prism Limited (if vou are
in amy other jurisdiction) are making the Decipher Intelligent Document Processing products
(the “Software”) and associated support services available to you.

These End User License and Support Terms, and the order (where “order” means an order
on the Blue Prism Order Form or other document agreed with us, or between you and an
authorized Blue Prism reseller (“Reseller™)). contain the whole agreement between you and ,

| accept the terms in the License Agreement

Pt || Back || Nee | | Camcel |

4. On the Destination Folder screen, click Next to accept the default location for Decipher Server
Plugin or click Change to specify a different location.

@ Decipher Server Plugin Setup — =

Destination Folder
Click Mext to install to the default folder or click Change to choose another. @

Install Decipher Server Plugin to:

|C:\F‘rogram Files {(x86)Blue Prism"Decipher Server'\Flugins

5. Click Install to complete the installation, followed by Finish to exit the wizard.

Commercial in Confidence Page 42 of 107



Decipher IDP 2.2 | Installation and Configuration
Ssk ‘ blueprlsm Standalone deployment

Configure Decipher IDP

When you have installed the SS&C Blue Prism and Decipher IDP components, you need to complete the
following configuration steps before you can get started. These should be done in the following order:

1. Configure database access:

* Grant system access (NT AUTHORITY) to the Decipher database (non-production
environments only)

* Configure Windows Authentication (production environments)
Secure the Decipher website with a Secure Sockets Layer (SSL) (production environments)
Ensure all Decipher services are running
Activate sites and services for Decipher IDP
Enable machine learning training (optional)
Update and encrypt database connection strings (optional)

Reporting database configuration (optional)

© N o g s~ Db

Configure RabbitMQ connection timeout (optional)

Grant system access (NT AUTHORITY) to the Decipher database (non-production
environments only)

‘ £ This configuration applies to single-server, non-production environments only.

The Decipher server service runs under the local system account. In order to access the Decipher
database, this user must be given access to the database. If you don't want to perform this step for the
current user, you could set Decipher to run as another user who has access to the database. The user
needs sufficient permissions to create the database and then read and write to it.

To give NT authority access to the Decipher database:

1. Open Microsoft SQL Server Management Studio and connect to the instance that is hosting your
Decipher database. If you installed SQL Express, the default for this is \SQLEXPRESS.

2. Click Security > Logins and double-click NT AUTHORITY\SYSTEM.
The Login Properties dialog displays.
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Click User Mapping and select the relevant the check boxes to ensure the user has db_datareader
and db_datawriter access to the Decipher database and the Decipher reporting database, if

applicable.
ogin Properties -
B LoginP ies - NT AUTHORITY\SYSTEM O
Select .
— g -+ @
& Server Roles
& User Mapping Users mapped to this login:
& Securables Map Database User Default Schema
& Status O BluePrism
O DecipherSearchCache
O | DeciherSever
[/] | DecipherServerDb NT AUTHORITY\SYS... dbo -]
[]  DecipherServerDbRe..  NT AUTHORITY\SYS.. dbo =]
Connection
Guest account enabled for: DecipherServerDb
Server:
BPEL252\SQLEXPRESS Database role membership for: DecipherServerDb
Connection: [] db_accessadmin
BPEU292\Bizabeth Stewart [] db_backupoperator
¢¥ Miew connection properties [] db_datareader
_datawriter
db_d
_ddladmin
db_ddlad
[] db_denydatareader
[] db_denydatawriter
Progress [] db_owner
[ db_securityadmin
Ready [+ public
OK || Canesl

Click OK to save the changes.
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Configure Windows Authentication (production environments)

For production environments, Blue Prism recommends the use of Windows Authentications using service
accounts.

g, The Decipher services and the website application pool must run under the context of a user that has
access to the relevant databases.

Configure the Decipher services
The following Decipher services must be configured with database access:

Service name Required database permissions k

Decipher Licensing The Blue Prism database to which db_datawriter / db_datareader
Service the Decipher license is applied.

Decipher Server The Decipher database. db_datawriter / db_datareader
; Decipher Web SDK The Decipher database. db_datawriter / db_datareader

To configure Windows authentication for each Decipher service listed above:

From Windows Services, right-click the Decipher service and select Properties.
Click the Log On tab and select This account.
Enter the location and password of your service account.

Perform this task for each Decipher service.

S

Restart the Decipher services.

Grant the service account access to Decipher folders

The service account used to access the Decipher databases also needs access to the following Decipher
folders:

* The Decipher Image Storage Path - This location is defined during the Decipher Server installation
and canbeviewed in: c:\Program Files (x86)\Blue Prism\Decipher Server)\
Ssiserver.exe.config underthe "ImageStorageRoot" key

* The Decipher application files - ¢ : \Program Files (x86)\Blue Prism\

* The default Decipher logging locations:
* C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue Prism\Blue
Prism

* C:\Windows\System32\config\systemprofile\AppData\Local\Decipher

* C:\Windows\System32\config\systemprofile\AppData\Local\Blue Prism

* The default website folder-c: \ inctpub\wwwroot
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Configure the Decipher website identity

The Decipher website identity should be set to an account that has db_datareader and db_datawriter
access to the Decipher database. The service account that was specified in the Service configuration can
be used.

To change the application pool identity:

Open Internet Information Services (1IS) Manager.
On the left-hand pane, navigate to Application Pools.
Select Decipher AppPool.

o wnh =

On the right-hand pane, click Advanced Settings.

‘f Internet Information Services (II5) Manager — m] x
(& [} BPEU292 » Application Pools o e -
File View Help
: o lication Pool '
Application Pools
& a PP Jé; Add Application Pool...
2 .
h B BEUEQE_ {BD_EUEQZ\EMHbEth This page lets you view and manage the list of application poels on the server, Application pools are associated with worker processes, SetApplicationiReuieatlon
B Application Pools centain one or more applications, and provide isolation ameng different applications, Application Pool Tasks
» -[@] Sites
Filter: ~ v Go - (54 Show All | Group by: Mo Grouping - L S
B Stop
Name Status  .MET CLRV.. Managed Pipel... Identity Applications 2 Recycle..
Q‘NEFVJ.S Started w40 Integrated ApplicationPoolld... 0 ot P
2 NET v4.5 Classic Started v Classic ApplicationPoolld... 0 Applcatin B
“TDecipher AppPool Started  wd0 Integrated LocalSystem 7 ] = Basic Settings...
~) DefaultAppPool Started v Integrated ApplicatienPoolld... 1 (=TT
Advanced Settings...
Rename
x Remove
View Applications
@ Help
Ready 9

The Advanced Settings dialog displays.
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5. Under Process Model, click Identity.
The ... (ellipsis) button displays.

Advanced Settings ? >
Start Mode OnDermand ”
v CPU
Limit (percent) 0
Limit Action Mobction
Lirnit Interval (minutes) 3
Processor Affinity Enabled False
Processor Affinity Mask 4294967295

Processor Affinity Mask (64-bit ¢ 4294967295
v Process Model

» Generate Process Model Event L

i ]

ldle Time-out (minutes) 10000

Idle Tirme-out Action Terminate

Load User Profile True

Maximum Worker Processes 1

Ping Enabled True

Ping Maximurm Response Time | 90

Ping Pericd (seconds) 30

Shutdown Time Limit (seconds) 90 W
|dentity

[identity Type, username, password] Configures the application pocl to run
as built-in account, i.e, Application Pool Identity (recommended), Network
Service, Local System, Local Service, or as a specific user identity.

QK Cancel

6. Click the ... (ellipsis) button.
The Application Pool Identity dialog displays.
7. Select Custom Account and click Set.

Commercial in Confidence Page 47 of 107



Decipher IDP 2.2 | Installation and Configuration
Ssk ‘ blueprlsm Standalone deployment

Application Pool |dentity 7 e

() Built-in account:

LocalSystem -

(® Custom account:

Set...

QK Cancel

8. Enter the account credentials, as prompted.
9. Once complete, navigate back to the Application Pools list.
10. Select Decipher AppPool and click the Recycle button.

Pasy Recycling the IS logs will log the user out of the current Decipher IDP session. If frequent recycling of
the IIS logs is required, it is recommended that this is scheduled for outside of operating hours.

Secure the Decipher website with a Secure Sockets Layer (SSL) (production
environments)
To secure your Decipher website to use an SSL certificate:
1. Open Internet Information Services (IIS) Manager.
2. Onthe left-hand pane, expand the Sites node and select Decipher.
3. Under Edit Site in the right-hand pane, click Bindings.
The Site Bindings dialog displays.
4. Click Add.
The Add Site Binding dialog displays.
5. From the Type drop-down, select hitps.
6. Add the host name of the Decipher Server to the Host name field.
7. Select an SSL certificate.

g, The SSL certificate drop-down is populated with certificates from the personal certificate store
on the local machine.

8. Click OK to accept the changes.
9. Navigate to the Decipher website and click Restart.

Any clients connecting to the Decipher website will have to trust the certificate that you selected in the
above process. Self-signed certificates will need to be imported onto client machines, but it is more
advisable to use a certificate from a certificate authority so that it is implicitly trusted by all clients.
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Check all Decipher services are running

Check that the necessary services exist and are running - you can do this by typing services into the
Windows search bar and checking these services:

° Decipher Automated Client Manager
* Decipher Licensing Service

* Decipher Server

ﬂ This service will not run until the LocalSystem user has been given access to the database; or
the Decipher Licensing Service has started.

* Decipher Web SDK Service
* RabbitMQ

Sg Services B . =
File Action View Help
@ |F EG= Hm » 80

O senices (owe) ([T Semicaattoaal |

Decipher Automated Client Name Description Status Startup Type Log On As &

Manager E@;[}ata Sharing Service Provides data brokering between ... Running  Manual (Trig...  Local System

Stop the service @gData Usage Metwork data usage, data limit, re.. Running  Automatic Local Service

Restart the service “CLDCOM Server Process Launcher The DCOMLAUNCH service launc... Running _Automatic Local System
&Decipher Automated Client Manager Decipher Automated Client Mana.. Running  Automatic (D... Local System

D " Eé:,’;[}ecipher Licensing Service Licensing mechanism for Blue Pri..  Running  Automatic Local System

escription: F . . . .

Decipher Automated Client Manager .@Declpher Server Decipher Server Service Running  Automatic (D... Local System

Service -@, Decipher Web SDK Service Decipher Web SDK Service Running  Automatic (D... Netwerk Service
& Delivery Optimization Performs content delivery optimi...  Running  Automatic (D... Network Service

See Troubleshooting if you encounter any issues starting the services.
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Activate sites and services for Decipher IDP

By default, IIS creates a website on port 80. If you want Decipher IDP to run on port 80, then this default
web site must be disabled or moved to avoid it conflicting with Decipher. To do this:

1. Open IIS and click the Sites folder in the Connections panel.

W Internet Information Services (IIS) Manager - o X
© @) mER® » Stes » Decipher » MO -
File View Help

Connections

2 0 Decipher Home
v & iza —
ﬂpmumuzfﬁ < Fiken - % Go - (G ShowAll | Groupby: Ares - E
ASPNET
= \J % © - =
3 @ e B B I Q& E B B
N NET  NETEvor  .NET  NETProfile NETRoles NETTust NETUsers Application Connection MachineKey Pagesand
Authorizat,. Compiation  Pages  Globalization Levels Setings  Strings Contrals

L

rs  Session State SMTP E-mail

s

= = = N
m & 4 @ 8 = 4 =

EvorPages  Handler ~ HTTP  ISAPIFikers Logging MIMETypes Modules  Outpu
Meppings  Respon, Cachin

4

Authentic... Compression

=
=
Request  SSL Seftings URL Rewrite
Fitering

Management

Configurat.
Editor

s | ot Vi Contere i

<
Ready 'i_:il

2. Select Default Web Site and click Stop on the Actions > Manage Website panel.
3. Select Decipher and click Start or Restart.

See Log on and set up Decipher IDP admin for next steps.

Enable machine learning training (optional)

Machine learning training can be switched on and off in the Decipher IDP user interface via Document
types. However, it first needs to be configured in the SsiDataCaptureClient.exe.config file.

1. Using Notepad++, open the SsiDataCaptureClient.exe.config file as an Admin. (The default location
iSC:\Program Files (x86)\Blue Prism\Decipher Automated Clients.)

2. Find <add key="EnableModelTrainingML" value="false" />and setthe value to true.

[ SsiDataCaptureClient exe config E1 |

1 |<?xml version="1.0" encoding="utf-8"?>

2 <configuration:>

3 <atartup uscelegacyVZ2RuntimeActivationPolicy="true">
4 <supportedRuntime version="v4.0" sku="_NETFramework,Version=v4.5" />
5] </fstartup>

& =l <appSettings>

7 <add key="ServerIp" value="127.0.0.1" />

8 <add key="ServerPort" value="12543" /=

a9 <add key="UserName" value="generaluser" />

10 <add key="Password" wvalus="user" />

11 <add ConnectionRetrySeconds" walus="120" />
1z <add MaxWorkerCount" walus="-1" />

13 <add RefreshTemplatesInMinutes" value="-1" />

14 <add OorSdkLogVerbosity" value="3" />

15 |<add y="EnableModelTrainingML" value="true" /> |

16 <add key="ClientSettingsProvider.ServiceUri" wvalue="" />

17 <add key="LogRoot" value="§{specialfolder:folder=LocalApplicationData}" />

18 <add kev="LogPath" walue="§{CompanyName} /DataCaptureClient/Logs" />

19 <add kev="LoglLayount" valus="§{longdate} [§{processid}-§{threadid}] ${level:uppercase=true} | ${message} ${exception:format=tostring}"
/>

20 <add key="LogsKeepForDays" wvalue="30" />

21 <add key="MinLoglLevel" values="Debug" />

22 <add key="DisableSelectiveTrainingDataUpdate" value="false" />

23 r </appSettings:

24 -</configuration>

3. Save the changes to the config file.

4. Restart the Decipher Server Service.

For information on why machine learning is not enabled by default, see the Decipher IDP frequently asked
questions.
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Update and encrypt database connection strings (optional)
For enhanced security, you can choose to encrypt your database connection settings.

Update the connection string

1. Using Notepad++, open the SsiServer.exe.config file. The default locationis c: \Program riles
(x86) \Blue Prism\Decipher Server\SsiServer.exe.config.

2. Find connectionstring and update the string with the name of the SQL database connection and
user credentials.

——
[ SsiServer exe corfig E1 |

1 <?xml version="1.0" encoding="utf-8"7> ~
2 E(configuzacion)

3 ] <configSections>

4 <gection name="ServerConfig" type="System.Configuration.AppSettingsSection" />

& <section name="DirectoryConfig" type="System.Configuration.AppSettingsSection" />

€ <section name="LicenseConfig" type="System.Configuration.AppSettingsSection" />

7 <gection name="TimeountConfig" type="System.Configuration.AppSettingsSection" />

8 <section name="WorkflowConfig" type="System.Configuration.AppSettingsSection" />

g r </configSectiomns>

10 = <startup>
11 <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.5" />

12 </startup>

13 <connectionStrings3|

14 <add name="SsiServerDb" connectionString="Data Source=.\SQLEXPRESS:Initial Catalog=DecipherServerDb:Integrated Security=True"
15 providerName="System.Data.SglClient" />

1€ <add name="SsiServerDbReporting" connectionString="" providerName="System.Data.SglClient" />
17 | </connectionStrings>

18 [ <ServerConfig>

ks <add ki Port" value="12543" />

20 <add k MaxRequestLength" valus="70000" />

21 <add k ReceiveBufferSize" value="256" />

2 <add key="SendBufferSize" value="256" />

23 <add key="CertificateFile" value="Cert\SsiServer.pfx" />
z4 - </ServerConfig>

25 [ <DirectoryConfig>

26 <add key="ImageStorageRoot" walue="C:\Decipher-storage" />
27 <add key="EncryptedStorage" value="false" />

28 <add kev="EncryptedKey" valus="false" />

29 <add key="StorageEncryptionFey" wvalus="" />

30 <add key="DataCacheEnabled" wvalue="false" />

31 <add key="UseThumbnailCache" valus="true" />

32 <add key="UseAbsoluteStoragePaths" valus="false" />

33 <add key="ImageStorageType" valus="FileSystem" />

34 <add key="ImageStorageConnectionString" wvalue="" />

35 r </DirectoryConfig>

36

<add key="VolumelicenseKey" valus="enc:AQAAANCMndSBFAERjHoAWE/Cl+sBAAAAOZBoCY 2waBeTu3RKgJ4 9CPOOAAAACAARAAAAQZGAAAARAACAAAADODODL]
<add key="FeaturelicenseKey" wvalue="" /> v
€ >

37 T <LicenseConfig>

g The existing connection string depends on whether the option to encrypt was selected when
installing Decipher Server, and how the user was configured. The following are examples of
typical connection strings:

e Data Source=.\SQLEXPRESS; Initial Catalog=DecipherServerDb; Integrated
Security=True;

* Data Source=.\SQLEXPRESS; Initial Catalog=DecipherServerDb; User
Id=myUsername; Password =myPassword;

° If already encrypted:
enc:AQAAANCMnd8BFAERjHOAWE /Cl+sBAAAAardddLezcO0amPmM328

3. Save the changes to the config file.

4. Restart the Decipher Server service.
Encrypt the connection string

1. Launch the command prompt.

2. Set the directory to the installation location, for example cd C:\pProgram Files (x86)\Blue
Prism\Decipher Server
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3. Enter ssiserver -enc and press Enter.

4. Restart the Decipher Server service to test if the configuration is successful. If the service does not
start, follow the Troubleshooting suggestions.

Reporting database configuration (optional)

If you have chosen to create a separate reporting database during the installation of the Decipher server,
you can then copy across any existing reporting data from the Decipher database to the new reporting
database.

1. Using Notepad++, open the SsiServer.exe.config file. The default locationis c:\Program Files
(x86) \Blue Prism\Decipher Server\SsiServer.exe.config.

2. FindworkflowConfigandsetthe syncoldbataToReportingbatabase valueto True.

[ SsiServer exe config B3 |

ARROGAAAAATARCAAAAAIVRSKNOPTLZLUNI i +15a0JZGEfECW3IFWOz P VEVEMOMAAAAAGAGTeAEV2C2Zn1ARD/igHECG/CYOHESGS1alWBtPE1nQOFh3hprENu30K9gF1G/ TXEB6 »~
LUWiye711v1BwwFPdhzyxOwEOxz10278L/PiQ/vza/aSYEYnzUcrwEXr 1hNe IVAAAAAIOhcEbgQt 6T7INNLIgZbSLrQSNFkOOSSECFZhL61DQxo /scHotyeCagkliras3hBE/
AyABmWAGDaGBrpAGpIdw==" />

46 <add key="PFeaturelLicenseRey" value="" />

47 <add key="PeatureLicenseFile" valus="" />

48 <add key="ProxyServer" walus="" />

49 <add key="LicenseConsumptionThresholdPercent"” walus="90" />
50  </LicenseConfig>

51

52 H <TimeoutConfig>

i <add key="BatchUserSendTimeoutMinutes" walue="10" />

54 <add key="BatchUserReceiveTimeoutMinutes" walus="10" />

55 <add key="BatchUserProcessTimeoutMinutes" walus="600" />

56 <add key="UserSessionTimeontMinutes" wvalus="90000" />

57 <add BatchImageStorageTimeoutDays" wvalue="30" />

58 <add OcrPerPageTimeoutSeconds" valus="90" /=

59 <add key="DataCapturePerPageTimeoutSeconds" value="40" />

&0 <add key="ClassifyPerPageTimeontSeconds" walus="10" />

6l <add key="ExportPerPageTimeountSeconds" walus="15" />

62 <add key="ImageProcessingPerFileTimeoutSeconds" wvalus="600" />
63 <add key="FieldTemplateMappingsLockTimecutSeconds" wvalue="300" />
64 <add key="CaptureModelLockTimecutSeconds" wvalue="1200" />

65 <add ki ClassificationModelLockTimeontSeconds" valus="1200" />
66 <add TemplateMergeLockTimeoutSeconds" valus="1200" />

67 <add key="TemplateMergeltemStoreTimeoutDays" valus="10" />
68 <add key="LogFileStorageTimeoutDays" wvalus="30" />

69 <add key="PerformDatabaseCleanupWithImageStorage" wvalue="false" />
70 | </TimeoutConfig>

71

72 B <WorkflowConfigs

23| "

T4

75

76

77 -

79 E <runtime>

80 <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
81 <probing privatePath=".;.\Plugins:.\CustomLie" />

82 F <fassemblyBinding>

83 r </runtime>

24 L</configuration>

g5

3. Save the changes to the config file.

4. Restart the Decipher Server service.

g Restarting the server may take some time while the data is copied across to the reporting
database.

Configure RabbitMQ connection timeout (optional)

When the Decipher Licensing Service is installed, there is a default RabbitMQ connection timeout of 5
seconds. If the component cannot connect to RabbitMQ in this time, it will timeout and an exception
message is logged in Windows Event Viewer: Failed to connect to RabbitMQ after 5 seconds of waiting.

If required, you can update the timeout value by editing the RabbitMgConnectionTimeoutinSeconds
attribute in the component's config file:
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1. In Windows Services, locate the Decipher Licensing Service, right-click and select Stop. You can
access Windows Services by typing Services into the Windows search bar.

2. Navigate to the Decipher Licensing Service config file. The default location is C:\Program Files
(x86)\Blue Prism\Decipher Licensing Service\config.

3. Open thefile in a text editor.

In the Configurations section, locate the rabbi tvgConnectionTimeout InSeconds attribute and
update the value as required. This must be a positive integer value.

—_
[~ config json E3 |

1

{
E "RabbitMg": {
"Endpoint™:
"CEDJSKcLODe SMOlAnfyTivLckWdrMech021IdtCNsflejgll IpxpgqWg2FBzIZlghosDHgX SERRENx J-TojPTzVoviTOUm3eRERI ISFT DgQOhK JxrVHs v
SkrVeaTMert&0uus4RheG-giXv_ZPdiNTWC=YIkK",
i "Username":
"CLDJSKcLO9DeSMOQLANLyUIXVLCKVI tDAPL8pAGSWeC ksLE3XHQIGMETmS]Thnw]Se J5o0lFdEeadnsecx3k kZjCcSlkGYWW4KC2c3nHycPTeJnQOI-3U
9-gPYH1yAN1SOfRiA"™,

w o

g "Password":
"CIDJSKcLeDeSMOlANEyTiXvLckWCLoV0Aabe0wnijhIce16mfbl fcoEZd-VhZTB2Z fARgFbej—vEt 3RE6JVXUBVESYgm3QisTOU-LNFL32ipfAGEFNFDTQvGL
NTrsTTxCViGgWinyQ"™,

6 "QueueHame":

"CEDJ8KcLIDeSMQl A FyUiXvLekVaF Tt SRbDOEv3uT SWFtKeQa2BCEwz kRUKVChudWgytel 1mawS¥o) ¥JeBS02CTU-80Tv52wal0F TyHxSxhe Y s5CFmDE
SAgE7Gus1YQEDpEgDEPw33_IAgcQDIET2gErgIn
Eoobe

-

2 [ "sglv: {

a "ConnectionScring”:
"CEDJEKcL9DeSMOIANfyUiXvLckUIMb1a ) DIKSTWOMx8£24J6YESetUwzPxDETMILyp  xrABF1UsTzx44cJZXG03jv_NvG4qYedV1495311 -KrilgjXkDSr
HEWOyU252xgWEX2Z-23aI7U5b2-1CFPDELRL1GpZiFoJvhe i Cox1X0pTRKBauHATEZa8B8eU6SyDLMBuSRhxFyl SpTAEHEIDs1_ keSIgMFSUpMWTCZS8H]
Srohb™

10 o}

11 Eo)

1z "Configurations": {

13 T "RakbbitMgConnectionTimeoutInSeconds™: S

1la }

1s } bd

5. Save the changes to the config file.

6. In Windows Services, restart the Decipher Licensing Service.

The Decipher Licensing Service will now use the updated timeout value.
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Multi-device deployment

This section describes the steps required for a multi-device installation. We recommend planning your
installation before installing and considering the information below, regarding different server
configurations and communication between the servers.

Decipher IDP requires the following six different server types, which can exist on separate machines, or be
combined as required:

° Blue Prism application server - This is the Blue Prism server and it needs to access SQL Server
and Decipher server.

* Decipher licensing server - Should contain the Decipher licensing service and have access to the
SQL server and an instance of RabbitMQ, either on the web server or a separate installation.

* Decipher server - Should contain the Decipher server and the Decipher server plugin and have
access to the SQL server and an instance of RabbitMQ, either on the web server or a separate
installation.

* Decipher clients server - Should contain Decipher automated clients and have access to the SQL
server and the Decipher server.

* Decipher web server - Should contain the Decipher Web Client, which includes RabbitMQ. It also
needs to have access to the SQL server and the Decipher server. Every web server must have a
local copy of RabbitMQ installed.

* SQL server - Should contain the SQL server database.

Suitable for production and non-production use, a typical deployment contains all components of Decipher
IDP deployed to separate machines and includes the application server.

Steps

For both standalone and multi-device installations, Decipher IDP must be installed and configured in the
following order. Each installation step has detailed instructions, or you can follow the relevant installation
video, where available.

https://bpdocs.blueprism.com/en-us/video/installation.htm.

Installation Step Link to instructional video (if
available)

1. Install and configure third-party software

‘ ® Instructional videos on how to install Decipher IDP and other Blue Prism products are available from: |

° Erlang ° Install Erlang
* RabbitMQ ° Install RabbitMQ
* SQL Server / SQL Server Express 2012 or later (minimum ° Install IS

requirement)
* SQL Server Management Studio (recommend, but not required)
* Internet Information Server (IIS)
2. Configure Rabbit MQ to allow remote runtime Video not currently available.

resources to push to Decipher IDP
° Add the Decipher hostname to the RabbitMQ configuration

° Create a new RabbitMQ user and set permissions
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Installation Step Link to instructional video (if
available)

3. Install and configure Blue Prism
° Install Blue Prism and create a Decipher database ° CopyDLL
* Copy the Decipher DLL — Copy to the Blue Prism install location ° Import VBO

for all Blue Prism interactive clients and runtime resources
using Decipher IDP

* Import the Decipher VBO — Import into every Blue Prism
interactive client that needs to interact with Decipher IDP

* Import the Decipher processes (release) — Import into every
Blue Prism interactive client that needs to interact with Decipher

IDP
4. Install Decipher IDP
* Decipher Licensing Service ° Install Decipher Licensing Service
* Decipher Server ° Install Decipher Server
* Decipher Web Client ° Install Decipher Web Client
° Decipher Automated Clients ° Install Decipher Automated Clients
* Decipher Server Plugin ° Install Decipher Server Plugin

5. Configure Decipher IDP
° Configure database access ° Configure database access — non-

* Grant system access (NT AUTHORITY) to the Decipher production environments
database (non-production environments only). ° Configure database access—

* Configure Windows Authentication (production production environments

environments). ° Add Decipher SQL location to
. . o Web.config
Secure the Decipher website with a Secure Sockets Layer (SSL)
(production environments). ° Activate Sites and Services for
* Add Decipher SQL location to Web.config Decipher IDP
* Check all Decipher services are running

° Activate Sites and Services for Decipher IDP — Update for all
web servers

* Enable machine learning training (optional)
6. Configure RabbitMQ on Decipher Server Video not currently available.

This step is only required for multi-device deployments, where
Decipher Server and the Decipher Server Plugin are installed on a
server that is remote from the Decipher Web Server

5. Log onto Decipher IDP
* You are ready to get started with Decipher IDP °* Log onto Decipher IDP
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Install and configure third-party software

You need to install and configure the following software and settings in the order listed below on a
dedicated PC before installing Decipher IDP.

ﬁ Please ensure that you have read the minimum requirements section, including the browser details,
before installing the third-party software and Decipher IDP components.

Erlang and RabbitMQ

The following components must be installed before installing Decipher IDP:
* Erlang OTP version 25.1.2
* RabbitMQ version 3.11.4

Function Erlang and RabbitMQ are required components and must be installed on the machine
on which the Decipher Web Client will be installed.

ﬁ RabbitMQ is installed using a default username and password. These credentials
are then automatically populated during the installation of the Decipher licensing
service. If you do not want to use the default RabbitMQ credentials, you will need
to amend them before installing Decipher licensing service and enter the new
credentials during installation. For details on changing the default credentials,
see RabbitMQ configuration.

Download The version of Erlang that you require is dependent on the RabbitMQ version you
intend to use. For more information, see RabbitMQ Erlang Version Requirements.

https://www.erlang.org/downloads
https://www.rabbitmqg.com/download.html

Install Run the installers and follow the instructions, accepting the default options when
prompted.
SQL Server
Function SQL Server Express 2012 is a minimum database requirement.

ﬁ. SQL Server Express is supported for proof of concept and evaluation purposes
only. Itis not recommended or supported for production use.

Download https://www.microsoft.com/en-us/sql-server/sqgl-server-downloads

SQL Server Express 2012 (or later) is the minimum requirement for a standalone
deployment of Decipher IDP.

Supported SQL Server Express 2012, 2016, 2017, 2019

SPPECAEIN SQL Server 2012, 2014, 2016, 2017, 2019
versions
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Run the installer and when prompted, select the basic installation type.

SQL Server 2019
Express Edition

Select an installation type:

é". The Blue Prism Decipher database should not be created at this stage of the
installation process. See Create a Blue Prim database for Decipher IDP on
page 64 for details.

SQL Server Management Studio

Function This is not a requirement for Decipher IDP installation, but is recommended to
configure and manage components within the SQL server.

For multi-device installations this will need to be installed on a user’'s machine only
where required.

Download https://docs.microsoft.com/en-us/sqgl/ssms/download-sql-server-management-studio-
ssms?redirectedfrom=MSDN&view=sql-server-ver15.

Under Download SSMS, click Download SQL Server Management Studio (SSMS) to
download the SSMS-Setup-ENU.exe.

Run the installer and follow the instructions, accepting the default options when
prompted.
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Internet Information Server (11S)

IIS needs to be configured on the web server. |IS settings are applied from the Windows control panel:
Programs > Programs and Features > Turn Windows Features on or off and select Internet Information
Services.

Ensure the following settings are applied:
Web Management Tools IIS Management Console

World Wide Web Services Application Development Features
* .NET Extensibility 3.5

* .NET Extensibility 4.7
° ASP .NET 4.7

* ISAPI Extensions

* ISAPI Filters

Common HTTP Features
° Default Document

* Directory Browsing
* HTTP Errors

° Static Content

Health and Diagnostics N/A
Performance Features N/A
Security N/A

Scripted installation

To apply the above settings automatically, run the command below using the PowerShell command
prompt:

Install-WindowsFeature -Name Web-Mgmt-Console, Web-Net-Ext, Web-Net-Ext45, Web-Asp-Net45, Web-
ISAPI-Ext, Web-ISAPI-Filter, Web-Default-Doc, Web-Dir-Browsing, Web-Http-Errors, Web-Static-
Content -computerName localhost -Restart
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.NET Core Components

Function The .NET Core components must be downloaded and installed.

Download Download the following components and store them in a temporary location, for
example, C:\temp:

* .NET Core Windows Server Hosting 3.1.3

https://dotnet.microsoft.com/en-us/download/dotnet/thank-you/runtime-
aspnetcore-3.1.3-windows-hosting-bundle-installer

* .NET Core Windows Desktop Runtime 3.1.3

https://dotnet.microsoft.com/en-us/download/dotnet/thank-you/runtime-desktop-
3.1.3-windows-x64-installer

* Visual C++ Redistributable 2012 (x64)

https://download.microsoft.com/download/1/6/B/16B06F60-3B20-4FF2-B699-
5E9B7962F9AE/VSU_4/vcredist_x64.exe

° .NET Framework 4.7.2

https://dotnet.microsoft.com/download/dotnet-framework/thank-you/net472-
web-installer

ﬁ, This is installed by default on Windows Server 2019. You only need to install
the .NET Framework if you are using Windows Server 2016.

Install To install the .NET dependencies, run each of the following commands using the
PowerShell command prompt, waiting until each completes, before running the next
command:

For Windows Server 2016:

start-process "C:\temp\dotnet-hosting-3.1.3-win.exe" /q -wait
start-process "C:\temp\windowsdesktop-runtime-3.1.3-win-x64.exe" /q -wait
start-process "C:\temp\vcredist_x64.exe" /q -wait

start-process "C:\temp\NDP472-KB4054531-Web.exe" /q -wait

For Windows Server 2019:

start-process "C:\temp\dotnet-hosting-3.1.3-win.exe" /q -wait
start-process "C:\temp\windowsdesktop-runtime-3.1.3-win-x64.exe" /q -wait
start-process "C:\temp\vcredist_x64.exe" /q -wait

ﬁ Ensure the file name and file path match the files that were stored in step 1.

Restart your server before installing Decipher IDP to ensure the components are fully
installed and registered.
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RabbitMQ configuration

The following information applies to multi-device configurations using RabbitMQ.

Configure RabbitMQ for remote runtime resources
In multi-device deployments, runtime resources will not be able to push documents to Decipher IDP unless
RabbitMQ has been configured to respond to the Decipher Server hostname as well as the localhost.

The following sections describe how to configure RabbitMQ to respond to the remote Decipher Server
hostname, and how to create a RabbitMQ user so that runtime resources can access RabbitMQ remotely.

Add the Decipher hostname to the RabbitMQ configuration
To edit the advanced.config file:

1. Navigate to the RabbitMQ application folder. The default location is:
C:/Users/<username>/AppData/Roaming/RabbitMQ

2. Open advanced.config with a text editor.

3. Replace the existing content with the following:
[{rabbit, [
{tcp listeners, [{"<hostname>",5672},{"0.0.0.0",5672}]}
]
}
1.
4. Replace <hostname> with the hostname of the Decipher Web Client machine hosting RabbitMQ and
save your changes.

5. Restart the server on which the Decipher Server component is installed and the server on which
RabbitMQ is installed, if different.

g, Port 5672, added to the RabbitMQ configuration described above, is the default port used to connect
to the RabbitMQbroker. Port 15672, used when creating a new RabbitMQ user, is a different port
used to connect the management console add on.

Create a new RabbitMQ user and set permissions
To create a new RabbitMQ user to access the RabbitMQ server remotely:

1. Open a browser and navigate to http.//localhost:15672/.
The RabbitMQ Management login screen displays.
2. Loginto RabbitMQ using guestas both the username and password.
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3. Select the Admin tab and click Add user.

Overview Connections Channels Exchanges Queues
Users
+ All users
Filter: [CJRegex ?
Name Tags Can access virtual hosts  Has password
decipheruser administrator /, pssandbox -
guest administrator / .

?

+ Add a user

Username: | guest

Password: w

Tags:

“ {confirm)
?
Set  Admin | Monitoring | Policymaker
Management | Impersonator | Mone

Add credentials for a new user for use with Decipher Server.

In the Tags field, enter administrator.
6. Click Add user.

Once created, the new user will display in the All users list.
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7. To grant administrator permissions to the new user, in the All users list, select the user you have just
created. The Permissions page for the selected user displays.

Overview Connections Channels Exchanges Queuess m

User: decipheruser

+ Overview

Tags | administrator

Can log in with password = &

+ Permissions

Current permissions

Virtual host  Configure regexp  Write regexp  Read regexp

/ ; ; i

Set permission

Virtual Host:

Configure regexp:
Write regexp:

Read regexp:

8. Inthe Set permission dialog, ensure the Virtual Host field contains the / character, and do not
amend the other default parameter settings.

9. Click Set permission to apply these permissions to the new user.

RabbitMQ will now respond to the Decipher Server hostname, enabling remote runtime resources to push
to Decipher IDP.

ﬁ You will also need to modify the RabbitMQ instance on the Decipher Server to configure remote
access to the RabbitMQ server, see Modify the RabbitMQ instance on the Decipher Server for
details.
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Install and configure Blue Prism
The following components are required to complete the steps below:

* Blue Prism

* Decipher DLL

* Decipher VBO

* Decipherv2.2.bprelease

‘ ﬁ For details of component versions see the release notes.

Install Blue Prism and create a database

If you do not already have Blue Prism installed, you will need to install Blue Prism 6.6 or later. If you
already have Blue Prism installed you just need to create a Blue Prism database for use with Decipher IDP
-you will need to reference this when installing the Decipher Licensing Service.

This is an overview of the steps required to install Blue Prism and create a database. You can find full
instructions on how to install, configure, and use our product in the Blue Prism help.
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Create a Blue Prim database for Decipher IDP
You need to create a new database for your Decipher IDP data.
Install and launch Blue Prism.

2. Inthe Sign in to Blue Prism screen, click Configure connection to launch the configure connection
wizard.

3. Click New Connection followed by Create Database.
In the Connection Configuration screen complete the following details:

Connection Name Enter an easily recognizable name for the connection.
Connection Type Select SQL Server (Windows Authentication).

Database Server Enter the network location of the SQL server instance.
If you have installed SQL Express as described in this
guide, this will be localhost\SQLEXxpress.

Database Name Enter a name for the new database, e.g. BluePrism.

/. BluePrismis the default database name when
installing the Decipher licensing service. If you
create a database using a different name, you
will need to enter this name when you install the
Decipher licensing service.

Additional SQL Connection This is not required.
Parameters

i Connection Configuration ? *

Store and recall different database connections

Saved Connections ‘Current Connection
Decipher
Connection Name Decipher
The name by which this connection will be remem bered
Connection Type SOL Server (Windows Authentication) ~
The type of connection to use
Database Server ‘Ioca\host\SQLExpress
The hostname of the database server
Database Name BlueFrism|
The name of the database to connect to
Additional SQL ‘
Connection Parameters  c.o; ooy separated parameters to add 1o the connection string
Test Connection
MNew Connection Delete Connection Create Database Upgrade Database Configure Database
OK Cancel

5. Select your required user authentication method and click OK to create the database.

Add Decipher IDP license to SS&C Blue Prism

You need a Decipher IDP license to run Decipher. This must be added to Blue Prism before installing
Decipher IDP.
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1. Log into Blue Prism.

ﬁ Ensure that you log into Blue Prism using the connection configured to use the database
created for Decipher IDP. This is because Decipher licensing will not work unless you apply
the license key to the Decipher database. You also need to ensure you specify this database

when installing the Decipher Licensing Service.

2. Click the System tab and select System > License from the navigation tree. Details of the active
license are displayed and options are available to install new licenses and remove existing ones.

3. Click Install new license to add the Decipher license.
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Add the Decipher DLL

For multi-device installations (any interactive client or runtime resource that will run the Decipher Blue
Prism processes), this DLL needs to be copied to the Blue Prism install location for all Blue Prism
interactive clients and runtime resources using Decipher IDP.

Paste the BluePrismDecipher.VBO.Interop.dll file into ¢ : \pProgram Files\Blue Prism Limited\Blue
Prism Automate.

This is the default install location so adjust it if you have used an alternative - just make sure it is in the
same directory as Automate.exe.

| = | Manage Blue Prism Automate — O x
Home Share View Application Toals - @
€« v 4 » ThisPC » 0O5(C) » Program Files (x86) » Blue Prism Limited » Blue Prism Automate v O Search Blue Prism Au.. 0
Program Files (x26) ~ MName - Date modified Type Size "
Adobe [] AppMan32.exe 28/01/2020 10:47 Application 46 KB
ASM104xUSE3 ¥ AppMan32.exe.config 28/01/2020 10:37 XML Configuratio... 5KB
AVAST Software Autofac.dll 16/10/2017 09:33 Application extens... 213 KB
Blue Prism Autofac.Extras.MLog.dll 24/05/201517:10 Application extens... 23 KB
. e > Automate.exe 28/01/2020 10:49 Application 169 KB
Blue Prism Limited ¥ Automate.exe.config 28/01/2020 1037 XML Configuratio.. 6 KB
Common Files AutomateAppCore.dll 28/01/202010:47  Application extens... 1,887 KB
CORVID [5] AutomateC.exe 28/01/2020 10:47  Application 129 KB
Dell %21 AutomateC.exe.config 28/01/2020 10:37 XML Configuratio... 5KB
Dell Digital Delivery Services iy AutomateConfig.exe 28/01/2020 10:47 Application 1,643 KB
dotnet ¥ AutomateConfig.exe.config 28/01/2020 10:37 XML Configuratio... 5KB
DurnrmyDir AutomateControls.dll 28/01/2020 10:46 Application extens... 844 KB
AutomateProcessCore.dll 28/01/2020 10:47 Application extens... 1,173 KB
Google B AutomateS.exe 28/01/202010:46  Application 2,327KB
InstaliShield Installation Information AutomateUL.dll 28/01/202010:49  Application extens... 12,950 KB
Intel BluePrism.ActiveDirectorylserSearcherdll  22/01/2020 10:47 Application extens... 220 KB
Internet Explorer v BluePrism.Browserfutomation.dll 28/01,/2020 10:46 Application exens... 95 KB W
149 items 1itemn selected 168 KB f=z| =
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Import the Decipher VBO
In Blue Prism select File > Import and import the BPA Object - Decipher.xml. This Decipher VBO can also
be used to create your own processes.

B Action Properties ? - O X

MName: Get Next Completed Batch
Description:

Business Object |De\:||:her = ‘ o Group:

Action |Get Mext Completed Batch " [rage [ Data Type

Inputs  Outputs  Conditions [ view Al items

Name Data Type Walue Binaries
[Queue Suffiy] - Collections

Dates

-~ DateTimes
Flags

. Images
Numbers

- Passwords
Text

.. Times

- TimeSpans

Stage logging: [ Dont log parameters on this stage
‘wiarning threshold: MNumber of minutes (0 to disable) I QK I | Cancel
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Import the Decipher release
Import this release into each separate Blue Prism environment that needs to interact with Decipher IDP.

The Decipher v2.2.bprelease contains a number of pre-built processes to help you use Decipher IDP.

Process Function Details
Decipher-01Push = Takes documents located in C:\/nvoices and Do not include more than
Documents pushes them to Decipher IDP as a single batch. 15 invoices in a batch.
Decipher - 02 Sample process to determine whether there are This returns True or
Batches to Verify batches in Decipher IDP that require manual False and can be used to
verification. build a process to send
notifications to users.
Decipher - 03 Get Sample process to retrieve verified documents N/A
Verified Documents  from Decipher IDP and put in a Blue Prism work
queue.
Decipher - 04 Get Takes the document data from Blue Prism work N/A
Decipher Item from = queue and pushes data into collection.
BP Queue

Select File > Import and select the Decipher v2.2.bprelease you downloaded from the portal. The
processes are added to the Processes\Default folder in Studio.
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Install Decipher IDP components

g, Before installing the Decipher IDP components, you will need to apply a valid Decipher IDP license to
the Decipher database in Blue Prism for Decipher IDP to work. See Decipher IDP licensing for
details.

The following components are required to complete the Decipher IDP installation and steps below and
must be installed in this order:

Decipher Licensing Service
Decipher Server
Decipher Web Client

Decipher Automated Clients

a bk~ wh =

Decipher Server Plugin

g, If you have already installed the beta version of Decipher IDP, you will need to use Windows
Add/Remove Programs to remove all of the (beta) Decipher components from all devices, before
installing this release. To avoid any issues, please then follow these installation instructions when re-
installing Decipher IDP.

You can download these files from the Decipher IDP product page of our customer portal. You can see the
component versions for each release in the release notes.

Depending on your current system setup you may need to restart your computer following installation
before Decipher IDP can be used.

Install Decipher Licensing Service

ﬁ RabbitMQ is installed using a default username and password. These credentials are then
automatically populated during the installation of the Decipher licensing service. If you do not want to
use the default RabbitMQ credentials, you will need to amend them before installing Decipher
licensing service and enter the new credentials during installation. For details on changing the
default credentials, see RabbitMQ configuration.

For multi-device installations, this needs to be installed on the Decipher Licensing Service.

1. Run the Decipher Licensing Service installer.

2. Click through the install wizard, following the on-screen instructions as prompted.
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3. Onthe End-User License Agreement screen, read the license agreement and select / accept the
terms in the License Agreement, if you accept these terms.

@ Decipher Licensing Service Setup — X
End-User License Agreement
Please read the Decipher Licensing Service License Agreement @
DECIPHER INTELLIGENT DOCUMENT ~
PROCESSING

END USER LICENSE AND SUPPORT TERMS

‘We (Blue Prism Software, Inc. (if you are in the Americas) or Blue Prism Limited (if vou are
in any other jurisdiction) are making the Decipher Intelligent Document Processing products
(the “Software™) and associated support services available to you.

These End User Licensze and Support Terms, and the order (where “order” means an order
on the Blue Prism Order Form or other document agreed with us, or between you and an
authorized Blue Prism reseller (“Reseller™)), contain the whole agreement between you and

e ralatine tn tha ehiset mabter harand and cab nnb bha baeme e tehich sn sen nea tha

v

[ | accept the terms in the License Agreement

[ Pt || Bak || met | | canel |

4. On the Destination Folder screen, click Next to accept the default location for Decipher Licensing
Service or click Change to specify a different location.

@ Decipher Licensing Service Setup — =

Destination Folder

Click Mext to install to the defautt location 6 bl u e p ”S m

Install Decipher Licensing Service to:

|C:\Program Files {x86)\Blue Prism"Decipher Licensing Service

Back || Net | | Cancel
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5. On the Configure SQL connection screen:
Ensure the correct SQL server is specified.

b. The Trusted (Windows Authentication) authentication mode is selected by default. This
setting is recommended for Decipher IDP, but can be changed if required.

A\ If using SQL Authentication, ensure your SQL password does not start with an equals
(=) sign or a semi-colon (;) as they are not supported and may lead to a corrupted
configuration file.

c. Enterthe name of your existing Blue Prism database. The Database name defaults to
BluePrism. If you have already created a Blue Prism database for Decipher using a different
name, enter that name in the Database name field.

ﬁ If you don’t enter the correct Decipher database name during this part of the installation,
as described above, Decipher IDP will not successfully run.

3 Decipher Licensing Service Setup — *
Configure SQL connection

Flease enter details for a SQL server instance for the Decipher Server to use

Please select SQL Server |BPEU292‘\SQLEXPRESS ~ | | Refresh

Authentication Mode
(® Trusted (Windows Authentication)
() Spedfy Username and Password (SQL Authentication)

Username

Password

Database name  |BluePrism

Back || mMext | | Concel
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6. On the RabbitMQ connection configuration screen the following details are completed by default:

The hostname of your RabbitMQ server. Commonly in development environments,
all components are installed on the same server, and therefore the default is
localhost. For multi-device environments, you will need to enter the name of the
RabbitMQ server.

Defaults to 5672.

Defaults to DecipherLicensing.

P Decipher Licensing Service Setup — x

RabbitMQ connection configuration
Amend the following RabbitMQ connection values as required

Host name

Port 5672 H

Queue name |DecipherLioensing

| Back || MNext | ‘ Cancel |

7. Click Next to continue. A message displays notifying you that a queue using the name you have
specified will be created in RabbitMQ. Click Yes to accept, or No if you want to go back and amend
the name.

8. On the RabbitMQ connection configuration screen enter the username and password for RabbitMQ.
The default is guest.

/. The RabbitMQ username and password entered here must match the RabbitMQ account - the
default RabbitMQ username and password are guest. For standalone deployments, the default
credentials are sufficient. If you created a different RabbitMQ user, enter the credentials for the
new user. You will be prompted to enter these credentials when installing the Decipher server.

9. Click Next.

10. On the Installation Summary screen, click Install to complete the installation, followed by Finish to
exit the wizard.

£, When the Decipher Licensing Service is installed, it is automatically configured with a default
RabbitMQ connection timeout of 5 seconds. If required, you can update the timeout value. For more
information, see Configure RabbitMQ connection timeout.
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Install Decipher Server

ﬁ If required, the separate reporting database must be created when installing/upgrading the Decipher
Server component.

For multi-device installations, this needs to be installed on the Decipher server.

1. Run the Decipher Server installer.
2. Click through the install wizard, following the on-screen instructions as prompted.

3. Onthe End-User License Agreement screen, read the license agreement and select / accept the
terms in the License Agreement, if you accept these terms.

75 Decipher Server Setup - X

End-User License Agreement ~
Please read the Decipher Server License Agreement @

Ll

DECIPHER INTELLIGENT DOCUMENT
PROCESSING

END USER LICENSE AND SUPPORT TERMS

'We (Blue Prism Software, Inc. (if you are in the Americas) or Blue Prism Limited (if you are
in any other jurisdiction) are making the Decipher Intelligent Document Processing products
(the “Software”) and associated support services available to you.

These End User License and Support Terms, and the order (whers “order” means an order
on the Blue Prism Order Form or other document aereed with us. or between vou and an v

| accept the terms in the License Agreement

Pt || Back || Nee | | Camcel |

4. On the Destination Folder screen, click Next to accept the default location for Decipher Server or
click Change to specify a different location.

ﬂ Decipher Server Setup — =

Destination Folder =
Click Mext to install to the default folder or click Change to choose anather. @

Install Decipher Serverto:

|C:\F‘rogram Files {x86)Blue Prism"Decipher Server
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5. Onthe Licensing screen, enter the following licensing details:

* Host name - The hostname of your RabbitMQ server. Commonly in development
environments, all components are installed on the same server, and therefore the default is
localhost. For multi-device environments, you will need to enter the name of the RabbitMQ
server.

* Queue name - The RabbitMQ queue name. The default is DecipherLicensing.

* Username and Password - The username and password for the RabbitMQ account that you
entered when installing the Decipher Licensing Service. The default RabbitMQ username and
passwords are guest, these credentials can only be used for standalone deployments.

g For multi-device deployments, you will need to first create a new RabbitMQ user to
access to RabbitMQ server remotely, see Create new RabbitMQ user and set
permissions for details. You will also need to modify the RabbitMQ instance on the
Decipher Server to configure remote access to the RabbitMQ server, see Modify the
RabbitMQ instance on the Decipher Serverfor details.

75 Decipher Server Setup - *

Licensing ~
Licensing credentials @
Host name: Port:
[localhost | [s672 H
Queue name:
|DecipherLicensing |
Usemame:
|g|.|est |
Password:
|.....| |

Back || Net | | Cancel |

Commercial in Confidence Page 74 of 107



Decipher IDP 2.2 | Installation and Configuration
SS&: ‘ bl Uepnsm Multi-device deployment

6. Onthe Database Server Configuration screen:
a. Ensure the correct SQL server is specified.

ﬁ If the SQL server is the MSSQLSERVER default instance, enter the machine name or
localhost. Entering the full name will result in the server not being found. Alternatively, if
you need to provide a different instance name, enter the machine name or localhost,

followed by | and the instance name.

b. The Trusted (Windows Authentication) authentication mode is selected by default. This
setting is recommended for Decipher IDP, but can be changed if required.

c. Click Test connection to proceed, followed by Next to continue.

;@ Decipher Server Setup — =

Database Server Configuration
Please configure database server connection
Click refresh to view LAN SQL Instances. Type URL or IP for remote SQL Instances
v||  Refresh |

Flease select SQL Server: |.‘\SQLEXPRESS

Authentication Mode
(@) Trusted (Windows Authentication)
(C) Spedify Username and Password (SQL Authentication)

Username:

Password:

Test connection to proceed
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7. Onthe Configure Server Settings screen complete the following details:

Server Database
Name

Image Storage Path

Server TCP Port

Install as Windows
Service

Encrypt All Data At
Rest

Encrypt Configuration

Enable reporting
database

Reporting database
on same server

Enter a new name for the server database, or accept the default
DecipherServerDb.

Enter the location in which to store the documents after they have
been processed. This can be any location, including OneDrive,
SharePoint, or a local drive. For example C:\Decipher storage.

Accept the default TCP port, or enter a different port number if
required. You will need to enter this port number when installing the
Decipher Web Client.

This option is selected by default. Do not deselect this option.

Select this option if you want to store all completed documents as
encrypted files. This is only necessary if the documents being
processed are confidential.

If enabled, you will need to configure an encryption password. If
enhanced security is required, enable the Encrypt the password
option.

ﬁ Decipher Server Setup — x
-
Encryption
Encryption corfiguration @

Encryption password:
| |

Corfirm password:

[ Encrypt the password

Back Next Cancel

Select this option if you want to encrypt the server settings.

Select this option to create a separate reporting database. A separate
reporting database enables you to retain report data for much longer.
This is also required to populate the accuracy and automation rates
reports.

For details of how to copy any existing reporting data from the
Decipher database to the new reporting database, see Reporting
database configuration.

If selected, the reporting database will be created on this server. This
option is selected by default.

ﬁ If required, the separate reporting database must be created when installing/upgrading the
Decipher Server component.
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}@ Decipher Server Setup
Configure Server Settings

FPlease configure the server

Server Database Name: |Decipher5erverDb

Image Storage Path: |

Server TCP Port:

[ 1nstall as Windows Service
[] Encrypt Al Data At Rest
[] Encrypt Configuration

] Enable reporting database
[~] Reporting database on same server

8. Click Next.

9. On the Installation Summary screen, click Install to complete the installation, followed by Finish to

exit the wizard.
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Install Decipher Web Client

For multi-device installations, this needs to be installed on the Decipher web server.
Run the Decipher Web Client executable.
Click through the install wizard, following the on-screen instructions as prompted.

On the End-User License Agreement screen, read the license agreement and select / accept the
terms in the License Agreement, if you accept these terms.

75 Decipher Web Client Setup - x

End-User License Agreement ~
Please read the Decipher Web Client License Agreement B

Ll

DECIPHER INTELLIGENT DOCUMENT
PROCESSING
END USER LICENSE AND SUPPORT TERMS
'We (Blue Prism Software, Inc. (if you are in the Americas) or Blue Prism Limited (if you are

in any other jurisdiction) are making the Decipher Intelligent Document Processing products
(the “Software”) and associated support services available to you.

These End User License and Support Terms, and the order (whers “order” means an order

ion the Bine Prism Order Form or other doenment aereed with n= or hetween von and an v

[ | accept the temma in the License Agreement

Pit || Back || Nex | Cancel
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4. On the Configuration screen complete the following details:

DESILENC M Accept the default install location.
Folder

Web Site Accept the default web site port, or enter a different port number if required.
Port

AVoJolI[e=1i[e]s M This IP address is required when you install the Decipher server.
Server
IP/URL

Ensure the same port number entered for Decipher Server is entered here.

AVsJolI[e1i[e]s M Enter the name of the SQL database connection. If you accepted the default
Database settings whilst installing Decipher Server, this will be:
Connection

Strmg Data Source=.\SQLEXPRESS;Initial Catalog=DecipherServerDb;Integrated
Security=True

If you didn’t accept the default options, this can be found in the
SsiServer.exe.config file, which is located in C:\Program Files (x86)\Blue
Prism\Decipher Server by default.

75 Decipher Web Client Setup - *

Decipher Web Client
Configuration
Destination Folder
|C:\Program Files (x86)Blue Prism | | Browse... |

Web Site Port:

Application Server IPYURL: Server Port:
[127.0.0.1 | [12543

Application Database Connection String
|3&=.\,5QLEXPRE55;InmaI Catalog=DedpherServerDb;Integrated 5ecur|ty=TrueI|

| Bak || met | | concel

5. Click OK to save the settings.

6. Click Install to continue to install Decipher Web Client, which may take several minutes, followed by
Close to exit the wizard.

ﬁ Windows security alerts may display for the erl.exe and the epmd.exe. For Decipher IDP to work
successfully you will need to allow them to communicate over your private networks.
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Install Decipher Automated Clients

For multi-device installations, this needs to be installed on the Decipher clients server.
1. Run the Decipher Automated Clients installer.
2. Click through the install wizard, following the on-screen instructions as prompted.

3. Onthe End-User License Agreement screen, read the license agreement and select / accept the
terms in the License Agreement, if you accept these terms.

ﬁ Decipher Automated Clients Setup — x

End-User License Agreement ~
Please read the Decipher Automated Clients License Agreement B

DECIPHER INTELLIGENT DOCUMENT
PROCESSING

END USER LICENSE AND SUPPORT TERMS

'We (Blue Prism Software, Inc. (if you are in the Americas) or Blue Prism Limited (if you are
in any other jurisdiction) are making the Decipher Intelligent Document Processing products
(the “Software”) and associated support services available to you.

These End User License and Support Terms, and the order (whers “order” means an order

ion the Bine Prism Order Form or other doenment aereed with n= or hetween von and an v

| accept the terms in the License Agreement

Pt || Back || Nee | | Camcel |

4. On the Destination Folder screen, click Next to accept the default location for Decipher Automated
Clients or click Change to specify a different location.

ﬁ Decipher Automated Clients Setup — =

Destination Folder >
Click Next to install to the default folder or click Change to choose anather. @

Install Decipher Automated Clients to

|C:\F‘rogram Files {(x86)Blue Prism"Decipher Automated Clients
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5. Onthe Custom Setup screen, select the relevant options.

For standalone deployments, select every option. For multi-device deployments, with multiple
automated clients, select only the features required for each installation.

ﬁ Decipher Autorated Clients Setup - >

-
Custom Setup
Select the way you want features to be installed. @

Click the icons in the tree below to change the way features wil be installed.

[ Classfication Cliernt

[-]10OCR Cliert

Data Capture Cliert
Machine Leaming Module

Export Cliert

Image Processing Client

6. On the Decipher Automated Clients Configuration Settings screen complete the following details:
Server IP/URL Ensure the same IP address entered in the Decipher Server is entered
here. The default IP address is 127.0.0.1.

Ensure the same port number entered for Decipher Server and the
Decipher Web Client is entered here. The default portis 72543.

Username generaluser This is the Decipher user that will run the different
modules to extract data from a document.

Password user

=Yoo lyiife [T 1] M Select this option to encrypt the Automated Client configuration
settings.

ﬁ Decipher Automated Clients Setup - >

Decipher Automated Clients Configuration Settings

Specify Application server connection settings
Server IPJURL |12?.0.0. 1 |

Port |12543 E"

Username |generaluser |

Password | |

[] Encrypt Configuration

Mote: The system is configured with a user "generaluser” with a password "user” by default.

| Bak || mswl | caneel |

7. Click Install to complete the installation, followed by Finish to exit the wizard.
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Install Decipher Server Plugin
For multi-device installations, this needs to be installed on the Decipher server.
1. Run the Decipher Server Plugin installer.
2. Click through the install wizard, following the on-screen instructions as prompted.

3. Onthe End-User License Agreement screen, read the license agreement and select / accept the
terms in the License Agreement, if you accept these terms.

i Decipher Server Plugin Setup — x
End-User License Agreement
Please read the Decipher Server Plugin License Agreement @
DECIPHER INTELLIGENT DOCUMENT ~
PROCESSING

END USER LICENSE AND SUPPORT TERMS

‘We (Blue Prism Software, Inc. (if you are in the Americas) or Blue Prism Limited (if vou are
in amy other jurisdiction) are making the Decipher Intelligent Document Processing products
(the “Software”) and associated support services available to you.

These End User License and Support Terms, and the order (where “order” means an order
on the Blue Prism Order Form or other document agreed with us, or between you and an
authorized Blue Prism reseller (“Reseller™)). contain the whole agreement between you and ,

| accept the terms in the License Agreement

Pt || Back || Nee | | Camcel |

4. On the Destination Folder screen, click Next to accept the default location for Decipher Server
Plugin or click Change to specify a different location.

@ Decipher Server Plugin Setup — =

Destination Folder
Click Mext to install to the default folder or click Change to choose another. @

Install Decipher Server Plugin to:

|C:\F‘rogram Files {(x86)Blue Prism"Decipher Server'\Flugins

5. Click Install to complete the installation, followed by Finish to exit the wizard.
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RabbitMQ configuration on Decipher Server

In multi-device deployments, where Decipher Server and the Decipher Server Plugin are installed on a
server that is remote from the Decipher Web Server, you may need to manually install and configure
RabbitMQ (and Erlang) on that server for the Blue Prism Server Plugin feature to operate.

ﬁ The RabbitMQ host name and the Decipher Web Client host name must be the same. If you amend
the default RabbitMQ host name, you must also update the Decipher Web Client host name. It will
not update automatically and will result in Decipher IDP not working as expected.

The DecipherServerConfiguration.exe application, which is available to download from the customer
portal, has been created by Blue Prism to enable you to modify the configuration and authentication details
of the RabbitMQ instance on the Decipher Server.

Modify the RabbitMQ instance on the Decipher Server

1. Run the DecipherServerConfigurator.exe.

2. Inthe Decipher Server configuration file path field, enter the location of the SsiServer.exe.config
file. If required, use the Browse... option to change the file path.

i Decipher Server Configurator — O >

hier Servert 5 =i | | Browse... | | Open

EIVEl e, Cohfic

e PrizmhDeci

Decipher Server configuration file path | G146

R abhittd 0 endpoint

Rabhittd port -

Rabbithd [ uzermnanme

Rabbitkd) pazsward

Apply

3. Click Open. The default local host endpoints and authentication details for RabbitMQ display.

i Decipher Server Configurator — O >

Decipher Server configuration file path  B]ABlue PrizmtDecipher ServertSsiSerer exe config Browsze... Open

Rabbitkd 1 endpaint |I|:u:alh|:|st |
Rabbittdd port  |5EY2 E|

R abbittd 0 uzermame | quest |

R abbittd Q) pazzword | **** |

Apply
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4. Update the RabbitMQ endpoint, RabbitMQ username, and RabbitMQ password fields with the
details specific to your RabbitMQ server. For example:

i Decipher Server Configurator — O ot

Decipher Server configuration file path  16]4Elue PrizmDecipher ServertSziServer exe. config Browse. .. Open

RiabhithQ endpoint | 192.168.56.101 |
Rabbithd port (5672 I

R abbitkd (] uzermame | admin |

R abbitkd [ pazzword

-l--l--l--l--l-l |

Apply

5. Click Apply. The tool will validate and update the SsiServer.exe.config with the amended details.
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Configure Decipher IDP

When you have installed the SS&C Blue Prism and Decipher IDP components, you need to complete the
following configuration steps before you can get started. These should be done in the following order:

1. Configure database access:

* Grant system access (NT AUTHORITY) to the Decipher database (non-production
environments only)

* Configure Windows Authentication (production environments)
Secure the Decipher website with a Secure Sockets Layer (SSL) (production environments)
Ensure all Decipher services are running
Activate sites and services for Decipher IDP
Enable machine learning training (optional)
Update and encrypt database connection strings (optional)

Reporting database configuration (optional)

© N o g s~ Db

Configure RabbitMQ connection timeout (optional)

Grant system access (NT AUTHORITY) to the Decipher database (non-production
environments only)

‘ £ This configuration applies to single-server, non-production environments only.

The Decipher server service runs under the local system account. In order to access the Decipher
database, this user must be given access to the database. If you don't want to perform this step for the
current user, you could set Decipher to run as another user who has access to the database. The user
needs sufficient permissions to create the database and then read and write to it.

To give NT authority access to the Decipher database:

1. Open Microsoft SQL Server Management Studio and connect to the instance that is hosting your
Decipher database. If you installed SQL Express, the default for this is \SQLEXPRESS.

2. Click Security > Logins and double-click NT AUTHORITY\SYSTEM.
The Login Properties dialog displays.
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Click User Mapping and select the relevant the check boxes to ensure the user has db_datareader
and db_datawriter access to the Decipher database and the Decipher reporting database, if

applicable.
ogin Properties -
B LoginP ies - NT AUTHORITY\SYSTEM O
Select .
— g -+ @
& Server Roles
& User Mapping Users mapped to this login:
& Securables Map Database User Default Schema
& Status O BluePrism
O DecipherSearchCache
O | DeciherSever
[/] | DecipherServerDb NT AUTHORITY\SYS... dbo -]
[]  DecipherServerDbRe..  NT AUTHORITY\SYS.. dbo =]
Connection
Guest account enabled for: DecipherServerDb
Server:
BPEL252\SQLEXPRESS Database role membership for: DecipherServerDb
Connection: [] db_accessadmin
BPEU292\Bizabeth Stewart [] db_backupoperator
¢¥ Miew connection properties [] db_datareader
_datawriter
db_d
_ddladmin
db_ddlad
[] db_denydatareader
[] db_denydatawriter
Progress [] db_owner
[ db_securityadmin
Ready [+ public
OK || Canesl

Click OK to save the changes.
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Configure Windows Authentication (production environments)

For production environments, Blue Prism recommends the use of Windows Authentications using service
accounts.

g, The Decipher services and the website application pool must run under the context of a user that has
access to the relevant databases.

Configure the Decipher services
The following Decipher services must be configured with database access:

Service name Required database permissions k

Decipher Licensing The Blue Prism database to which db_datawriter / db_datareader
Service the Decipher license is applied.

Decipher Server The Decipher database. db_datawriter / db_datareader
; Decipher Web SDK The Decipher database. db_datawriter / db_datareader

To configure Windows authentication for each Decipher service listed above:

From Windows Services, right-click the Decipher service and select Properties.
Click the Log On tab and select This account.
Enter the location and password of your service account.

Perform this task for each Decipher service.

S

Restart the Decipher services.

Grant the service account access to Decipher folders

The service account used to access the Decipher databases also needs access to the following Decipher
folders:

* The Decipher Image Storage Path - This location is defined during the Decipher Server installation
and canbeviewed in: c:\Program Files (x86)\Blue Prism\Decipher Server)\
Ssiserver.exe.config underthe "ImageStorageRoot" key

* The Decipher application files - ¢ : \Program Files (x86)\Blue Prism\

* The default Decipher logging locations:
* C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue Prism\Blue
Prism

* C:\Windows\System32\config\systemprofile\AppData\Local\Decipher

* C:\Windows\System32\config\systemprofile\AppData\Local\Blue Prism

* The default website folder-c: \ inctpub\wwwroot
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Configure the Decipher website identity

The Decipher website identity should be set to an account that has db_datareader and db_datawriter
access to the Decipher database. The service account that was specified in the Service configuration can
be used.

To change the application pool identity:

Open Internet Information Services (1IS) Manager.
On the left-hand pane, navigate to Application Pools.
Select Decipher AppPool.

o wnh =

On the right-hand pane, click Advanced Settings.

‘f Internet Information Services (II5) Manager — m] x
(& [} BPEU292 » Application Pools o e -
File View Help
: o lication Pool '
Application Pools
& a PP Jé; Add Application Pool...
2 .
h B BEUEQE_ {BD_EUEQZ\EMHbEth This page lets you view and manage the list of application poels on the server, Application pools are associated with worker processes, SetApplicationiReuieatlon
B Application Pools centain one or more applications, and provide isolation ameng different applications, Application Pool Tasks
» -[@] Sites
Filter: ~ v Go - (54 Show All | Group by: Mo Grouping - L S
B Stop
Name Status  .MET CLRV.. Managed Pipel... Identity Applications 2 Recycle..
Q‘NEFVJ.S Started w40 Integrated ApplicationPoolld... 0 ot P
2 NET v4.5 Classic Started v Classic ApplicationPoolld... 0 Applcatin B
“TDecipher AppPool Started  wd0 Integrated LocalSystem 7 ] = Basic Settings...
~) DefaultAppPool Started v Integrated ApplicatienPoolld... 1 (=TT
Advanced Settings...
Rename
x Remove
View Applications
@ Help
Ready 9

The Advanced Settings dialog displays.
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5. Under Process Model, click Identity.
The ... (ellipsis) button displays.

Advanced Settings ? >
Start Mode OnDermand ”
v CPU
Limit (percent) 0
Limit Action Mobction
Lirnit Interval (minutes) 3
Processor Affinity Enabled False
Processor Affinity Mask 4294967295

Processor Affinity Mask (64-bit ¢ 4294967295
v Process Model

» Generate Process Model Event L

i ]

ldle Time-out (minutes) 10000

Idle Tirme-out Action Terminate

Load User Profile True

Maximum Worker Processes 1

Ping Enabled True

Ping Maximurm Response Time | 90

Ping Pericd (seconds) 30

Shutdown Time Limit (seconds) 90 W
|dentity

[identity Type, username, password] Configures the application pocl to run
as built-in account, i.e, Application Pool Identity (recommended), Network
Service, Local System, Local Service, or as a specific user identity.

QK Cancel

6. Click the ... (ellipsis) button.
The Application Pool Identity dialog displays.
7. Select Custom Account and click Set.
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Application Pool |dentity 7 e

() Built-in account:

LocalSystem -

(® Custom account:

Set...

QK Cancel

8. Enter the account credentials, as prompted.
9. Once complete, navigate back to the Application Pools list.
10. Select Decipher AppPool and click the Recycle button.

Pasy Recycling the IS logs will log the user out of the current Decipher IDP session. If frequent recycling of
the IIS logs is required, it is recommended that this is scheduled for outside of operating hours.

Secure the Decipher website with a Secure Sockets Layer (SSL) (production
environments)
To secure your Decipher website to use an SSL certificate:
1. Open Internet Information Services (IIS) Manager.
2. Onthe left-hand pane, expand the Sites node and select Decipher.
3. Under Edit Site in the right-hand pane, click Bindings.
The Site Bindings dialog displays.
4. Click Add.
The Add Site Binding dialog displays.
5. From the Type drop-down, select hitps.
6. Add the host name of the Decipher Server to the Host name field.
7. Select an SSL certificate.

g, The SSL certificate drop-down is populated with certificates from the personal certificate store
on the local machine.

8. Click OK to accept the changes.
9. Navigate to the Decipher website and click Restart.

Any clients connecting to the Decipher website will have to trust the certificate that you selected in the
above process. Self-signed certificates will need to be imported onto client machines, but it is more
advisable to use a certificate from a certificate authority so that it is implicitly trusted by all clients.
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Check all Decipher services are running

Check that the necessary services exist and are running - you can do this by typing services into the
Windows search bar and checking these services:

° Decipher Automated Client Manager
* Decipher Licensing Service

* Decipher Server

ﬂ This service will not run until the LocalSystem user has been given access to the database; or
the Decipher Licensing Service has started.

* Decipher Web SDK Service
* RabbitMQ

Sg Services B . =
File Action View Help
@ |F EG= Hm » 80

O senices (owe) ([T Semicaattoaal |

Decipher Automated Client Name Description Status Startup Type Log On As &

Manager E@;[}ata Sharing Service Provides data brokering between ... Running  Manual (Trig...  Local System

Stop the service @gData Usage Metwork data usage, data limit, re.. Running  Automatic Local Service

Restart the service “CLDCOM Server Process Launcher The DCOMLAUNCH service launc... Running _Automatic Local System
&Decipher Automated Client Manager Decipher Automated Client Mana.. Running  Automatic (D... Local System

D " Eé:,’;[}ecipher Licensing Service Licensing mechanism for Blue Pri..  Running  Automatic Local System

escription: F . . . .

Decipher Automated Client Manager .@Declpher Server Decipher Server Service Running  Automatic (D... Local System

Service -@, Decipher Web SDK Service Decipher Web SDK Service Running  Automatic (D... Netwerk Service
& Delivery Optimization Performs content delivery optimi...  Running  Automatic (D... Network Service

See Troubleshooting if you encounter any issues starting the services.
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Activate sites and services for Decipher IDP

By default, IIS creates a website on port 80. If you want Decipher IDP to run on port 80, then this default
web site must be disabled or moved to avoid it conflicting with Decipher. To do this:

1. Open IIS and click the Sites folder in the Connections panel.

W Internet Information Services (IIS) Manager - o X
© @) mER® » Stes » Decipher » MO -
File View Help

Connections

2 0 Decipher Home
v & iza —
ﬂpmumuzfﬁ < Fiken - % Go - (G ShowAll | Groupby: Ares - E
ASPNET
= \J % © - =
3 @ e B B I Q& E B B
N NET  NETEvor  .NET  NETProfile NETRoles NETTust NETUsers Application Connection MachineKey Pagesand
Authorizat,. Compiation  Pages  Globalization Levels Setings  Strings Contrals

L

rs  Session State SMTP E-mail

s

= = = N
m & 4 @ 8 = 4 =

EvorPages  Handler ~ HTTP  ISAPIFikers Logging MIMETypes Modules  Outpu
Meppings  Respon, Cachin

4

Authentic... Compression

=
=
Request  SSL Seftings URL Rewrite
Fitering

Management

Configurat.
Editor

s | ot Vi Contere i

<
Ready 'i_:il

2. Select Default Web Site and click Stop on the Actions > Manage Website panel.
3. Select Decipher and click Start or Restart.

See Log on and set up Decipher IDP admin for next steps.

Enable machine learning training (optional)

Machine learning training can be switched on and off in the Decipher IDP user interface via Document
types. However, it first needs to be configured in the SsiDataCaptureClient.exe.config file.

1. Using Notepad++, open the SsiDataCaptureClient.exe.config file as an Admin. (The default location
iSC:\Program Files (x86)\Blue Prism\Decipher Automated Clients.)

2. Find <add key="EnableModelTrainingML" value="false" />and setthe value to true.

[ SsiDataCaptureClient exe config E1 |

1 |<?xml version="1.0" encoding="utf-8"?>

2 <configuration:>

3 <atartup uscelegacyVZ2RuntimeActivationPolicy="true">
4 <supportedRuntime version="v4.0" sku="_NETFramework,Version=v4.5" />
5] </fstartup>

& =l <appSettings>

7 <add key="ServerIp" value="127.0.0.1" />

8 <add key="ServerPort" value="12543" /=

a9 <add key="UserName" value="generaluser" />

10 <add key="Password" wvalus="user" />

11 <add ConnectionRetrySeconds" walus="120" />
1z <add MaxWorkerCount" walus="-1" />

13 <add RefreshTemplatesInMinutes" value="-1" />

14 <add OorSdkLogVerbosity" value="3" />

15 |<add y="EnableModelTrainingML" value="true" /> |

16 <add key="ClientSettingsProvider.ServiceUri" wvalue="" />

17 <add key="LogRoot" value="§{specialfolder:folder=LocalApplicationData}" />

18 <add kev="LogPath" walue="§{CompanyName} /DataCaptureClient/Logs" />

19 <add kev="LoglLayount" valus="§{longdate} [§{processid}-§{threadid}] ${level:uppercase=true} | ${message} ${exception:format=tostring}"
/>

20 <add key="LogsKeepForDays" wvalue="30" />

21 <add key="MinLoglLevel" values="Debug" />

22 <add key="DisableSelectiveTrainingDataUpdate" value="false" />

23 r </appSettings:

24 -</configuration>

3. Save the changes to the config file.

4. Restart the Decipher Server Service.

For information on why machine learning is not enabled by default, see the Decipher IDP frequently asked
questions.
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Update and encrypt database connection strings (optional)
For enhanced security, you can choose to encrypt your database connection settings.

Update the connection string

1. Using Notepad++, open the SsiServer.exe.config file. The default locationis c: \Program riles
(x86) \Blue Prism\Decipher Server\SsiServer.exe.config.

2. Find connectionstring and update the string with the name of the SQL database connection and
user credentials.

——
[ SsiServer exe corfig E1 |

1 <?xml version="1.0" encoding="utf-8"7> ~
2 E(configuzacion)

3 ] <configSections>

4 <gection name="ServerConfig" type="System.Configuration.AppSettingsSection" />

& <section name="DirectoryConfig" type="System.Configuration.AppSettingsSection" />

€ <section name="LicenseConfig" type="System.Configuration.AppSettingsSection" />

7 <gection name="TimeountConfig" type="System.Configuration.AppSettingsSection" />

8 <section name="WorkflowConfig" type="System.Configuration.AppSettingsSection" />

g r </configSectiomns>

10 = <startup>
11 <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.5" />

12 </startup>

13 <connectionStrings3|

14 <add name="SsiServerDb" connectionString="Data Source=.\SQLEXPRESS:Initial Catalog=DecipherServerDb:Integrated Security=True"
15 providerName="System.Data.SglClient" />

1€ <add name="SsiServerDbReporting" connectionString="" providerName="System.Data.SglClient" />
17 | </connectionStrings>

18 [ <ServerConfig>

ks <add ki Port" value="12543" />

20 <add k MaxRequestLength" valus="70000" />

21 <add k ReceiveBufferSize" value="256" />

2 <add key="SendBufferSize" value="256" />

23 <add key="CertificateFile" value="Cert\SsiServer.pfx" />
z4 - </ServerConfig>

25 [ <DirectoryConfig>

26 <add key="ImageStorageRoot" walue="C:\Decipher-storage" />
27 <add key="EncryptedStorage" value="false" />

28 <add kev="EncryptedKey" valus="false" />

29 <add key="StorageEncryptionFey" wvalus="" />

30 <add key="DataCacheEnabled" wvalue="false" />

31 <add key="UseThumbnailCache" valus="true" />

32 <add key="UseAbsoluteStoragePaths" valus="false" />

33 <add key="ImageStorageType" valus="FileSystem" />

34 <add key="ImageStorageConnectionString" wvalue="" />

35 r </DirectoryConfig>

36

<add key="VolumelicenseKey" valus="enc:AQAAANCMndSBFAERjHoAWE/Cl+sBAAAAOZBoCY 2waBeTu3RKgJ4 9CPOOAAAACAARAAAAQZGAAAARAACAAAADODODL]
<add key="FeaturelicenseKey" wvalue="" /> v
€ >

37 T <LicenseConfig>

g The existing connection string depends on whether the option to encrypt was selected when
installing Decipher Server, and how the user was configured. The following are examples of
typical connection strings:

e Data Source=.\SQLEXPRESS; Initial Catalog=DecipherServerDb; Integrated
Security=True;

* Data Source=.\SQLEXPRESS; Initial Catalog=DecipherServerDb; User
Id=myUsername; Password =myPassword;

° If already encrypted:
enc:AQAAANCMnd8BFAERjHOAWE /Cl+sBAAAAardddLezcO0amPmM328

3. Save the changes to the config file.

4. Restart the Decipher Server service.
Encrypt the connection string

1. Launch the command prompt.

2. Set the directory to the installation location, for example cd C:\pProgram Files (x86)\Blue
Prism\Decipher Server

Commercial in Confidence Page 93 of 107



Decipher IDP 2.2 | Installation and Configuration
Ssk ‘ bl Uepnsm Multi-device deployment

3. Enter ssiserver -enc and press Enter.

4. Restart the Decipher Server service to test if the configuration is successful. If the service does not
start, follow the Troubleshooting suggestions.

Reporting database configuration (optional)

If you have chosen to create a separate reporting database during the installation of the Decipher server,
you can then copy across any existing reporting data from the Decipher database to the new reporting
database.

1. Using Notepad++, open the SsiServer.exe.config file. The default locationis c:\Program Files
(x86) \Blue Prism\Decipher Server\SsiServer.exe.config.

2. FindworkflowConfigandsetthe syncoldbataToReportingbatabase valueto True.

[ SsiServer exe config B3 |

ARROGAAAAATARCAAAAAIVRSKNOPTLZLUNI i +15a0JZGEfECW3IFWOz P VEVEMOMAAAAAGAGTeAEV2C2Zn1ARD/igHECG/CYOHESGS1alWBtPE1nQOFh3hprENu30K9gF1G/ TXEB6 »~
LUWiye711v1BwwFPdhzyxOwEOxz10278L/PiQ/vza/aSYEYnzUcrwEXr 1hNe IVAAAAAIOhcEbgQt 6T7INNLIgZbSLrQSNFkOOSSECFZhL61DQxo /scHotyeCagkliras3hBE/
AyABmWAGDaGBrpAGpIdw==" />

46 <add key="PFeaturelLicenseRey" value="" />

47 <add key="PeatureLicenseFile" valus="" />

48 <add key="ProxyServer" walus="" />

49 <add key="LicenseConsumptionThresholdPercent"” walus="90" />
50  </LicenseConfig>

51

52 H <TimeoutConfig>

i <add key="BatchUserSendTimeoutMinutes" walue="10" />

54 <add key="BatchUserReceiveTimeoutMinutes" walus="10" />

55 <add key="BatchUserProcessTimeoutMinutes" walus="600" />

56 <add key="UserSessionTimeontMinutes" wvalus="90000" />

57 <add BatchImageStorageTimeoutDays" wvalue="30" />

58 <add OcrPerPageTimeoutSeconds" valus="90" /=

59 <add key="DataCapturePerPageTimeoutSeconds" value="40" />

&0 <add key="ClassifyPerPageTimeontSeconds" walus="10" />

6l <add key="ExportPerPageTimeountSeconds" walus="15" />

62 <add key="ImageProcessingPerFileTimeoutSeconds" wvalus="600" />
63 <add key="FieldTemplateMappingsLockTimecutSeconds" wvalue="300" />
64 <add key="CaptureModelLockTimecutSeconds" wvalue="1200" />

65 <add ki ClassificationModelLockTimeontSeconds" valus="1200" />
66 <add TemplateMergeLockTimeoutSeconds" valus="1200" />

67 <add key="TemplateMergeltemStoreTimeoutDays" valus="10" />
68 <add key="LogFileStorageTimeoutDays" wvalus="30" />

69 <add key="PerformDatabaseCleanupWithImageStorage" wvalue="false" />
70 | </TimeoutConfig>

71

72 B <WorkflowConfigs

23| "

T4

75

76

77 -

79 E <runtime>

80 <assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
81 <probing privatePath=".;.\Plugins:.\CustomLie" />

82 F <fassemblyBinding>

83 r </runtime>

24 L</configuration>

g5

3. Save the changes to the config file.

4. Restart the Decipher Server service.

g Restarting the server may take some time while the data is copied across to the reporting
database.

Configure RabbitMQ connection timeout (optional)

When the Decipher Licensing Service is installed, there is a default RabbitMQ connection timeout of 5
seconds. If the component cannot connect to RabbitMQ in this time, it will timeout and an exception
message is logged in Windows Event Viewer: Failed to connect to RabbitMQ after 5 seconds of waiting.

If required, you can update the timeout value by editing the RabbitMgConnectionTimeoutinSeconds
attribute in the component's config file:
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1. In Windows Services, locate the Decipher Licensing Service, right-click and select Stop. You can
access Windows Services by typing Services into the Windows search bar.

2. Navigate to the Decipher Licensing Service config file. The default location is C:\Program Files
(x86)\Blue Prism\Decipher Licensing Service\config.

3. Open thefile in a text editor.

In the Configurations section, locate the rabbi tvgConnectionTimeout InSeconds attribute and
update the value as required. This must be a positive integer value.

—_
[~ config json E3 |

1

{
E "RabbitMg": {
"Endpoint™:
"CEDJSKcLODe SMOlAnfyTivLckWdrMech021IdtCNsflejgll IpxpgqWg2FBzIZlghosDHgX SERRENx J-TojPTzVoviTOUm3eRERI ISFT DgQOhK JxrVHs v
SkrVeaTMert&0uus4RheG-giXv_ZPdiNTWC=YIkK",
i "Username":
"CLDJSKcLO9DeSMOQLANLyUIXVLCKVI tDAPL8pAGSWeC ksLE3XHQIGMETmS]Thnw]Se J5o0lFdEeadnsecx3k kZjCcSlkGYWW4KC2c3nHycPTeJnQOI-3U
9-gPYH1yAN1SOfRiA"™,

w o

g "Password":
"CIDJSKcLeDeSMOlANEyTiXvLckWCLoV0Aabe0wnijhIce16mfbl fcoEZd-VhZTB2Z fARgFbej—vEt 3RE6JVXUBVESYgm3QisTOU-LNFL32ipfAGEFNFDTQvGL
NTrsTTxCViGgWinyQ"™,

6 "QueueHame":

"CEDJ8KcLIDeSMQl A FyUiXvLekVaF Tt SRbDOEv3uT SWFtKeQa2BCEwz kRUKVChudWgytel 1mawS¥o) ¥JeBS02CTU-80Tv52wal0F TyHxSxhe Y s5CFmDE
SAgE7Gus1YQEDpEgDEPw33_IAgcQDIET2gErgIn
Eoobe

-

2 [ "sglv: {

a "ConnectionScring”:
"CEDJEKcL9DeSMOIANfyUiXvLckUIMb1a ) DIKSTWOMx8£24J6YESetUwzPxDETMILyp  xrABF1UsTzx44cJZXG03jv_NvG4qYedV1495311 -KrilgjXkDSr
HEWOyU252xgWEX2Z-23aI7U5b2-1CFPDELRL1GpZiFoJvhe i Cox1X0pTRKBauHATEZa8B8eU6SyDLMBuSRhxFyl SpTAEHEIDs1_ keSIgMFSUpMWTCZS8H]
Srohb™

10 o}

11 Eo)

1z "Configurations": {

13 T "RakbbitMgConnectionTimeoutInSeconds™: S

1la }

1s } bd

5. Save the changes to the config file.

6. In Windows Services, restart the Decipher Licensing Service.

The Decipher Licensing Service will now use the updated timeout value.
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Install and configure the Natural Language Processing (NLP)
plugin

The NLP plugin can be downloaded from the Decipher IDP page on the Blue Prism customer portal.

Install the NLP plugin

The NLP plugin, GPU, and the Decipher automated client must be installed on the same machine.

‘ ﬁ An instructional video of the NLP plugin installation is available here.

Prerequisites
Ensure the following before attempting to install the NLP plugin:

* The specified minimum requirements have been met.
* Decipher IDP is already installed.
To install the NLP plugin:

1. Run the Decipher NLP Plugin installer.
2. Click through the install wizard, following the on-screen instructions as prompted.

3. Onthe End-User License Agreement screen, read the license agreement and, if you accept these
terms, select | accept the terms in the License Agreement, then click Next.

#5° Decipher NLP Plugin Setup — x

End-User License Agreement >
Pleaze read the Decipher MLP Plugin License Agreement @

M

DECIPHER INTELLIGENT DOCUMENT
PROCESSING

END USER LICENSE AND SUPPORT TERMS

We (Blue Prism Software, Inc. (jf you are in the Americas) or Blue Prism Limited (if vou are in
ary other furisdiction) are making the Decipher Intelligent Document Processing products (the
“Software”) and aszociated suppert services available to you.

These End User Licensz and Support Terms, and the order (where “order” means an order on
the Blue Prism Order Form or other document agreed with us, or between you and an authorized

Ehia Priem receller (M Raallar™ ~antain the whals soreement hatwrsen sion and ne relating tn

W

[ I accept the terms in the License Agreement

. Pt || Back Next Cancel
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The Installing Decipher NLP Plugin screen displays.

Installing Decipher MLP Plugin

Installing Decipher NLP Plugin B7

Please wait while the Setup Wizard installs Decipher MLP Plugin.

Status: Migrating feature states from related applications
|

Back Mext Cancel

4. After the plugin has installed, click Next.
5. Onthe Completed the Decipher NLP Plugin Setup Wizard screen, click Finish to exit the wizard.

ﬁ Decipher MLP Plugin Setup

Completed the Decipher NLP Plugin Setup
Wizard

Click the Finish button to exit the Setup Wizard.

Back Cancel

The NLP plugin is installed to the following location:
SSI AUTOMATED CLIENTS ROOT INSTALLATION DIR\DataCaptureML\unstructured.
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Configure the NLP plugin
After you have successfully installed the NLP plugin, you will need to ensure that machine learning training
isenabled inthe ssipatacaptureClient.exe.config file.

1. Using a text editor, openthe ssibataCaptureClient.exe.config file, which is found in the
Decipher Web install folder. (The default locationis ¢ : \Program Files (x86)\Blue
Prism\Decipher Automated Clients\SsiDataCaptureClient.exe.config)

2. FindEnableModelTrainingmn and change the value to t rue.

—_——
| SsiDataCaptureClient exe.config E3 |

1 <?xml version="1.0" encoding="untf-8"7>

2 <configuration>

3 <startup uselegacyVZRuntimeActivationPolicy="true">

2 <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.5" />

5 </starcup>

13 = <appSettings>

T <add key="ServerIp" wvalue="127.0.0.1" />

8 <add key="ServerPort" value="12543" />

i) <add key="UserName" value="generaluser" />

10 <add key="Password" wvalue="user" />

11 <add key="ConnectionRetrySeconds" wvalus="120" />

12 <add key="MaxWorkerCount" valus="-1" />

13 <add key="RefreshTemplatesInMinutes" wvalues="-1" />

14 <add key="OcrSdkLogVerbosity" wvalue="3" />

15 add key="EnableModelTrainingML" wvalue="false" />

16 <add key="ClientSettingsProvider.ServiceUri" wvalue="" />

17 <add key="LogRoot" walus="§{specialfolder:folder=LocalApplicationData}" />

18 <add key="LogPath" walus="§{CompanyName} /DataCaptureClient/Logs" />

19 <add key="LogLayout" walus="§{longdate} [${processid}-${threadid}] §{level:uppercase=trus} | ${message} §{exception:format=tostring}"
P

20 <add key="LogsKeepForDays" valus="30" />

21 <add key="MinLoglLevel" walue="Debug" />

22 <add key="DisableSelectiveTrainingDataUpdate" wvalus="false" />

23 - </appSettings>

2a L</configuration>

3. Save the amended file.

See Natural Language Processing (NLP) plugin for details on how to configure and use the plugin in
Decipher IDP.
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Verify SQL databases

After installation, the following databases should have been created - you can check in SQL Server
Management Studio:

SQL Database Default Blue Prism Database Name |

Blue Prism BluePrism

Decipher IDP DecipherServerDb
Decipher IDP reports DecipherServerDbReporting
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Silent install

A Downloading and installing any of the Decipher IDP components, including by silent installation via
command line, means that you accept the End User License Terms.

The Decipher Licensing Service, Decipher Server, Decipher Web Client, Decipher Automated Clients,
Decipher Server Plugin, NLP Plugin, and a separate reporting database can be installed via the command
line using the commands in the sections below:

‘ ﬁ Commands must be run from an elevated command prompt to perform silent install.

Decipher IDP component installation commands
Run the following command line arguments for either fresh install or upgrade:

Decipher Licensing Service

Fresh install

start /wait msiexec /i "Decipher Licensing Service.msi" /gqn /norestart /log .\log.txt

Decipher Server

Fresh install

start /wait msiexec /i "Decipher Server 2.22.10050.msi" /qn /1 .\install.txt SERVERPORT=12543
DBNAME=DecipherServerDb STORAGEPATH=C:\DecipherImageStore LICUSER=guest LICPASS=guest WINSERVICE=1
DBSERVER="dec-ws2019-0\SQLEXPRESS" DBAUTHTYPE=1 DBUSER=<username> DBPASS=<password>

Upgrade

start /wait msiexec /i "Decipher Server 2.22.10050.msi" /qn /1 .\install.txt

Decipher Web Client

Fresh install

start /wait msiexec /i "Decipher Web Client 2.23.02150.msi" /gqn /norestart /log .\log.txt
INSTALLDIR="C:\Program Files (x86)\Blue Prism" WEBSITEPORT=80 SERVERIP=127.0.0.1 SERVERPORT=12543
DBCONNSTR="Data Source=dec-ws2019-0\SQLEXPRESS;Initial Catalog=DecipherServerDb;User
ID=<userid>;Password=<password>"

Upgrade

start /wait msiexec /i "Decipher Web Client 2.23.02150.msi" /gqn /norestart /log .\log.txt
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Decipher Automated Clients

Fresh install

start /wait msiexec /i "Decipher Automated Clients 2.23.02140.msi" /qn /1 .\log.txt
InstallDir="C:\Program Files (x86)\Blue Prism\Decipher Automated Clients" ServerIP=127.0.0.1
serverport=12543 serveruser=generaluser serverpass=user AddLocal=Common_Files,Server_Common_
Files,Data_Capture_Client,O0CR_Client,Image_Processing Client,Machine_Learning_
Module,Classification_Client,Export_Client

Upgrade

start /wait msiexec /i "Decipher Automated Clients 2.23.02140.msi" /gqn /1 .\log.txt

Decipher Server Plugin

Fresh install

start /wait msiexec /i "Decipher Server Plugin.msi" /gn /norestart /log .\log.txt

NLP Plugin

Fresh install

start /wait msiexec /i "Decipher NLP Plugin 2.23.02140.msi" /qn /1 .\log.txt

Upgrade
As there is only one release of the NLP plugin, the upgrade command is not currently required.

Command line parameters

Parameter Component Description

DBSERVER Decipher Server The name of the SQL server, or the Azure server
database connection string.

DBAUTHTYPE Decipher Server Authentication type - this can be:

* 0-Trusted (Windows Authentication)

/. This is the default and recommended for
Decipher IDP.

° 71-SQL Authentication

DBUSER Decipher Server Username for the database. Only required for
SQL authentication.

DBPASS Decipher Server Password for the database. Only required for
SQL authentication.

DBNAME Decipher Server The name of the database. The default is
DecipherServerDb.
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STORAGEPATH Decipher Server The image storage path. This is the location where
the documents are stored after they have been
processed. This can be any location, including
OneDrive, SharePoint, or a local drive.

LICENSEKEY Decipher Server The license key for the Decipher software.
WINSERVICE Decipher Server They type of install:

* 0-Install the server as a console application.
* 1-Install the server as service (default).

ENCRYPTION Decipher Server The encryption requirement for completed
documents:

* false- Completed documents are not encrypted
(default).

° true- All completed documents are encrypted.
This is only necessary if the documents being
processed are confidential.

ENCRYPTIONPWD Decipher Server The encryption password.

ENCRYPTEDPWD Decipher Server The encryption requirement for the encryption
password:

° 0-The password will not be encrypted (default).

* 1-The password will be encrypted.

LICHOST Decipher Server The RabbitMQ server host name. The default is
localhost.
LICPORT Decipher Server The RabbitMQ server port. The default is 5672.
LICQUEUE Decipher Server The RabbitMQ server queue name. The default is
DecipherLicensing.
LICUSER Decipher Server The RabbitMQ username.
LICPASS Decipher Server The RabbitMQ password.
SERVERPORT Decipher Server, The port of the server. The defaultis 72543. This is
Decipher Web required when installing the Decipher Web Client.
Client, and
Decipher
Automated Clients
DBCONNSTR Decipher Web The SQL application or Azure server database
Client connection string.
INSTALLDIR Decipher Web The installation directory. This does not need to be

Client and Decipher = passed if the default directory is used.
Automated Clients

SQL_SERVER Decipher Licensing  The SQL Server type, or the Azure server database
Service connection string.
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SQL_USERNAME Decipher Licensing = The username for SQL Server Authentication.
Service Required if SQL_AUTH_MODE is false.

SQL_PASSWORD Decipher Licensing  The password for SQL Server Authentication.
Service Required if SQL_AUTH_MODE is false.

SQL_DATABASE_ Decipher Licensing = The SQL database name. The default is BluePrism.
NAME Service

SQL_AUTH_MODE Decipher Licensing ~ The authentication mode. This can be:

Service * true- Trusted (Windows Authentication)

/. This is the default and recommended for
Decipher IDP.

° false-SQL Authentication

RMQ_USERNAME Decipher Licensing =~ The RabbitMQ username. The default is guest.
Service

RMQ_PASSWORD Decipher Licensing = The RabbitMQ password. The default is guest.
Service

RMQ_HOST_NAME Decipher Licensing = The RabbitMQ host name. The default is localhost.
Service

RMQ_PORT Decipher Licensing = The RabbitMQ port number. The defaultis 5672.
Service

S [eelS/SBISM NS Decipher Licensing ~ The RabbitMQ queue name, which must contain
Service alphanumeric characters only. The default is
DecipherLicensing.

Where appropriate, each property is initialized with the default value if it is not specified on the command
line.

Reporting database command line parameters
The following command line parameters can be used for the silent install of a separate reporting database

on Decipher Server.
REPORTING Specifies if the reporting database is enabled or disabled. This can be:
° true
* false
The default for clean install is false.

REPORTSAMESVR Specifies if the reporting database should be created on the same SQL
Server instance as the main database. This can be:

° true
* false
The default is true.
REPDBSERVER The name of the SQL Server instance to be used for the reporting database.
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REPDBAUTHTYPE

REPDBUSER
REPDBPASS
REPDBNAME

The Authentication type for the reporting server. Works analogically to
DBAUTHTYPE:

* 0-Windows Authentication

ﬁ This is the default and recommended for Decipher IDP.

* 1-SQL Server Authentication
The username for the reporting server. Required if REPDBAUTHTYPE is 1.
The password for the reporting server. Required if REPDBAUTHTYPE is 1.

The name of the reporting database. The default value is DBNAME
appended with Reporting.
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Default file locations

The default locations of Decipher IDP’s configuration and log files are shown in the sections below.

Log file locations

g, The default log locations were updated with the release of Decipher IDP 2.1, but logs for existing
installations upgrading from versions 1.2 or earlier were not changed. For details on how to re-
configure the log locations, see Upgrade Decipher IDP.

Application Server

File Location

type
Config C:\Program Files (x86)\Blue Prism\Decipher Server\log4net.config

Logs C:\Windows\System32\config\systemprofile\AppData\Local\Decipher\Applicatio
nServer\Logs

Classification

File type | Location

Config C:\Program Files (x86)\Blue Prism\Decipher Automated
Clients\SsiClassificationClient.exe.config

Logs C:\Users\Public\Blue Prism\ClassificationClient\Logs

For systems using 1.2 or earlier:

C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue
Prism\ClassificationClient\Logs

Capture
File type | Location
Conﬁg C:\Program Files (x86)\Blue Prism\Decipher Automated
Clients\SsiDataCaptureClient.exe.config
Logs C:\Users\Public\Blue Prism\DataCaptureClient\Logs
For systems using 1.2 or earlier:
C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue
Prism\DataCaptureClient\Logs
Export
File type | Location
Config C:\Program Files (x86)\Blue Prism\Decipher Automated

Clients\SsiExportClient.exe.config
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File type | Location

Logs C:\Users\Public\Blue Prism\ExportClient\Logs

For systems using 1.2 or earlier:

C:\Windows\SysWOW64\config\systemprofile\AppDatal\Local\Blue
Prism\ExportClient\Logs

Image Processing

Conﬁg C:\Program Files (x86)\Blue Prism\Decipher Automated
Clients\SsiImageProcessingClient.exe.config

Logs C:\Users\Public\Blue Prism\ImageProcessingClient\Logs

For systems using 1.2 or earlier:

C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue
Prism\ImageProcessingClient\Logs

OCR
File type | Location
Config C:\Program Files (x86)\Blue Prism\Decipher Automated
Clients\SsiOcrClient.exe.config
Logs C:\Users\Public\Blue Prism\OcrClient\Logs
For systems using 1.2 or earlier:
C:\Windows\SysWOWe64\config\systemprofile\AppData\Local\Blue
Prism\OcrClient\Logs
Web Client
File type | Location
Conﬁg C:\Program Files (x86)\Blue Prism\Decipher Web\NLog.config
Logs C:\Users\Public\Blue Prism\DecipherWebServer\Logs

For systems using 1.2 or earlier:

C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue
Prism\DecipherWebServer\Logs

Configuration file locations

RabbitMQ

File type | Location

Config N/A
Logs $appdata%$\RabbitMQO\1log\
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Web installer

File type | Location

Config N/A

Logs %temp% - there are 4 log files, whose names start with Blue Prism_Invoices_Web_Client_

C:\Users\{username}\AppData\Local\Temp

Web SDK Service/SDKWrapper

Config C:\Program Files (x86)\Blue Prism\Decipher Web SDK
Service\SdkWrapper\Ssi.SdkWrapper.exe.config

Logs C:\Users\Public\Blue Prism\SdkService\Logs
C:\Users\Public\Blue Prism\SdkWrapper\Logs
For systems using 1.2 or earlier:

If started under NetworkService (default):
C:\Windows\ServiceProfiles\NetworkService\AppData\Local\Blue Prism

If started under LocalSystem (deprecated):
C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue
Prism\SDKWrapper\Logs
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